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AVAILABLE REPORTS IN THE STANDARD PROGRAM 

Base Reports 
 Clients 
 Horses 
 Farms 
 Boarding Types 
 Horse List by Client 

 
 
Misc. Reports 

 Arrival 
 Departure 
 Departure Form 
 Horse Notes 
 Health Record 
 Mini Pedigree 
 Horse Movement 

 
 
Mare Reports 

 Foaling 
 Breeding 
 Outside Bookings 
 Farm Mares Bred Summary 
 Broodmares 
 Mare List by Client 
 Teasing Worksheet 
 Teasing Results Report 
 Foaling Mares By Location 
 

  
Fertility Analysis Reports 

 Farm-Mares:  Mares by Month 
 Farm-Mares:  Mares by Mare Type 
 Farm-Mares:  Mares by Stud Farm 
 

 
  
Additional Reports 

 Labels  
 Report Writer   
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Procedure Reports 

 Procedures Performed 
 Procedure Category 
 Procedure Master 
 Schedule Master 
 Schedule Procedures Due 

 
 

A/R Transaction Reports 
 Payments 
 Adjustments 
 Aged A/R 
 Detailed A/R 
 Unapplied Payments 
 Credit Invoices 
 Unapplied Payments with Unpaid Invoices 
 Billed Charges 

 
 
Billing: Standard > Preliminary Reports 

 Pre-Billing 
 Adjustments 
 Payments 
 Boarding 
 Service Charges 
 Service Tax 
 Preliminary A/R 
 Detail A/R 
 Closing Summary 
 Board & Procedure Revenue 
 Invoices 
 
 

Billing: Standard > Historical Reports 
 Board and Procedure Revenue 
 Adjustments 
 Payments 
 Boarding 
 Service Charges 
 Service Tax 
 Aged A/R 
 Detail A/R 
 Closing Summary 
 Board & Procedure Revenue 
 Invoices 
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Mare Info Reports 

 Foaling 
 Breeding 
 Outside Bookings 
 Farm Mares Bred Summary 
 Broodmares 
 Mare List by Client 
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MENU OPTIONS IN THE STANDARD PROGRAM 

 
Master Files Menu 
 

 
 
 

 
 
Procedures Menu 
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A/R Transactions Menu 
 

 
 

 
 
 
 
Billing Menu 
 

Preliminary Reports 
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Historical Reports 
 

 
 
 
Mare Information Menu 
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Reports Menu 
 

1. Base Reports 
 

 
 
 

2. Misc. Reports 
 

 
 
 

3.  Procedure Reports 
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4.  Mare Reports 

 

 
 
 

5.  Fertility Analysis Reports 
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Setup Menu 
 

Billing Setup 
 

 
 
 

Security 
 

 
 
 
 

Utilities 
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     Registration 
 

 
 
 
 
Online Verification 

 

 
 
 
 
 
 
Help Menu 
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FAQ 
 
This displays a list of Frequently Asked Questions and their corresponding 
answers.  The list includes questions and answers related to Installation of HFM, 
Setup, A/R Transactions, Procedure Entry, Mare Information Entry and Billing. 
 

 
 
 
 
Information for Backups 
 
This shows the location of the files you should back up on a regular basis.  The 
Database holds all of the information that you have entered into HFM and the 
Save Folder contains all of the invoices that have been saved during month end 
closing.  You should back up these files on a regular basis.  
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SQL Loader 
 
This is used to apply patches to your database and should only be used under 
the direction of a TJCIS support person. 
 

 
 
 
 
 
Send Database To TJCIS 
 
This menu option is in Development and is currently not available. 
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Check for Updates 
 

 
 
From this screen you can check your program & database versions, go to Fast 
Support under the direction of a TJCIS support person, you can go directly to 
The Jockey Club website or you can Upload your datafile directly to TJCIS. 
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Click Here to goto FastSupport 

 
This will be used under the direction of a TJCIS support person and it will allow 
the support person to see your computer screen at the same time as you.  You 
will enter your farm/company name and the TJCIS support person will provide 
you with the Support Key. 
 
 
 
Click here to access the TJCIS Upload Site 
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This TJCIS File Upload page will be used if you need to send your datafile 
directly to a TJCIS support person.  You will click “Browse” to locate your datafile 
and then you will click “Upload” to send your datafile to TJCIS, 
 
 
About Horse Farm Management System 
 

  
 
Note:  This is an informational page.   You can check to see which HFM Version 
you are currently running. 
 
This example shows Version 4.2.2.04 (A)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A
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General Information about Horse Farm Management 
 

Field Colors 
Throughout the program you will see different colored fields for entry. The 
following colors are the default settings. These default settings can be changed 
for individual users by going to Setup > Preferences > User Settings and 
selecting different colors from the drop down list. 
  
Yellow fields: Require information to be entered before the record can be saved. 
Green fields: These fields appear in pairs and indicate that information must be 

entered in either one or the other field (or both fields). 
White fields: Indicate that the information is optional, but it would be in your best 

interest to fill in as much information as you can. 
Gray fields: Are “display only” fields and do not allow users to make any 

changes.  
 
 Tip:  To see when a record was created and then who updated it, 

look in the “Audit Log” area on the screen. It will indicate the 
created by and date and time for the person that created the entry 
as well as information on the last time/date the entry was updated. 

 
General steps to add information into the system 

There are two basic ways to add information into the system.  Most of the 
entry forms have an ADD button that opens the form and allows the user 
to enter the new information.  On some forms, the information is presented 
to the user in a list format.  On these forms there will be a NEW button.  
Click the NEW button and after an empty line has been inserted you can 
type in a new entry for the list. 
 

General steps to edit information in the system 
To edit existing information, the system has been designed to allow the 
user to first “lookup” or find the record that needs changing.  Once the 
record has been located, most forms allow the user to directly change 
values. 
 

General steps to delete information from the system  
The best way to delete a record is by using the DELETE button on the 
listing forms.  You first select the record you wish to remove and click the 
DELETE button on the form.  The system will prompt to double check that 
you are sure you want to delete.  After you confirm, the record will be 
removed.  Warning:  Once a record has been removed, it cannot be 
“undeleted”.  The information would have to be re-entered by the user. 
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Inactive Records 
You have the option of marking records as inactive.  Records that can be 
marked as inactive are:  Farms, Clients, Horses, Procedure Categories, 
Procedure Masters and Boarding Types.  To mark a record as inactive, 
open the record and click in the box marked “Active” to remove the check.  
When the Active box is unchecked, that item will no longer appear in drop 
down lists. (A) 
 
Farm Entry/Edit 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A
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Client Entry/Edit 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A
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Horse Entry/Edit 
 
 

 
 
 
Procedure Category Entry/Edit 
 

 
 
 
 
 
 
 
 
 

A 

A 
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Procedure Master Entry/Edit 
 

 
 
 
 
Boarding Type Entry/Edit 
 

 
 
 
 
 
 

A 

A 
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Once you have marked an item as “Inactive” you can always search for it 
by “Un-checking” the Show Active Only box on the individual search 
screens.  When the Show Active Only box is unchecked, you will see both 
the Active and the Inactive items in the search list.
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 GETTING STARTED 

For this “Getting Started” section, all of the different methods of 
entering/editing data are not covered.  While the system can handle many 
types of farms and operating styles, this section is meant to show the user 
just one way of using the software.  This “quick start” will give most farms a 
straightforward way to immediately begin using the system.   

 
Getting Started – Just the Basics 

After the Horse Farm Management System has been installed and you 
have called The Jockey Club to complete the registration process, you 
should take the following basic steps in order to begin setting up and using 
the program.  Please keep in mind that some steps must be completed 
before you can continue to the next step.  For example, you will need to 
set up your client list before you set up your horses because the system 
requires that you enter the horse ownership before exiting the horse 
master screen. 
 

The following is the recommended order for entering your information. 
This section also provides a brief overview.  A detailed “How To” begins 
on page 31. 

 
 
Set Up Your Company First 
 
(Setup > Companies) 
On the Company Search screen, highlight the name “Place Your Name HERE” 
and click the Edit button.   
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On the Company Entry/Edit screen, go to the “Name” field, DELETE the words 
“Place Your Name HERE” and then type in your own company/farm name.  
Enter your address and then enter your phone number, fax number, etc. and 
click “Save” when done.  If you need to, you can come back to this screen at a 
later time and set up additional companies. 
 
 
 
NEXT  

Set up Farms  
 (Master Files > Farms) 

Click the Add button and enter your farm first and any other information 
such as address and phone number.  When finished, click the “Save” 
button.  Add any other farms that you will be interacting with during the 
course of the year.  Other “Farm” entries could include the stallion farm 
where your mare will be sent for breeding or the name of a clinic where 
you might send horses for veterinary services or the name of the track 
where your horse is currently in training. 
 

Select and Review Preferences   
  (Setup > Preferences) 

Application Settings > Company Settings 
 Select a default breed from the drop down list 
 Select your farm name from the drop down list as the “Default 

Farm”  
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Set up Clients  
 (Master Files > Clients) 

Click the “Add” button and first add yourself as a client and then 
add each of your clients, whether an individual, a farm, a company, 
etc.  Enter as much information as you have on each client and 
click “Save”. 

 
Set up Boarding Types 

 (Master Files > Boarding Types) 
Add a “Boarding Type” for each type of horse you have on your 
farm and the daily rate you will be charging for each Boarding type. 
The board type is used for billing and the daily rate is the amount a 
horse will be charged per day to board with you. (Mare, Mare under 
lights, Barren mare, Mare pasture board, Foal, Weanling, Yearling, 
Sales Prep, etc.) 

 
Set up Horse Types 
                 (Master Files > Horse Types) 

Similar boarding types can be grouped together in one Horse Type 
making it easier to produce lists or perform mass procedures. For 
example, you may have Mare, Mare under lights, Barren mare or 
Mare pasture board but they are all “Mares”.  If you have a Horse 
Type of “Mare”, you can associate all of the other “Mare Boarding 
Types” to the Horse Type of “Mare”. 
    

Set up Procedure Categories 
  (Master Files > Procedure Categories) 

Add general categories that your specific procedures will fall within 
such as:  (Blacksmith, De-Worm, Vaccinations, Medical, Vanning, 
Tack & Equipment, Reproductive, Registration/Nominations, 
Outside Vet, etc). 

 
Set up Procedure Masters 

  (Master Files > Procedure Masters) 
Add each of the specific procedures that may be performed on a 
horse and the standard charge if there is one. (Palpation, 
Ultrasound, Trim 4, Coggins, Foal Profile, Tetanus Vaccination, 
Jockey Club Registration, Neck Strap, Culture, etc). 
 

Set up Horses  
 (Master Files > Horses) 

Add all horses that are currently on your farm or horses that you 
wish to track.  Enter an Ownership date and select the owner’s 
name from the client master list. Enter an arrival date if the horse 
has arrived on your farm and select a Boarding Type. 
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Review Master Lists  

 (Setup > Master Lists) (Optional) 
You should review the categories so that you are familiar with the 
items in each category and make changes as needed.  To add an 
item to a category click the “New” button, type in your entry and 
then click “Save”. 

 
Review Billing Setup 

 (Setup > Billing Setup) (Optional) 
Billing Codes. The system has been preloaded with all necessary 
G/L codes.  Only if your farm uses specific G/L accounting codes 
will you need to change them.  
Service Charge. If you charge late fees for overdue invoices, then 
enter codes for each rate you plan to use.   
G/L Account Setup. The system has been preloaded with all 
necessary G/L codes.  Only if your farm uses specific G/L 
accounting codes will you need to change them. 

 
Initial A/R Client Balances for New Users Only 

 (Setup > Billing Setup > A/R Maintenance) 
For each client listed, type in any outstanding balances from your 
previous billing in the appropriate column (Current, Over 30, Over 
60, Over 90, Service Charges).  The amount entered here will show 
up as the beginning balance on the client’s first invoice. 
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DETAILED WALK THROUGH 

 
The following section outlines the step-by-step process of setting up your farm’s 
information and entering your horses’ daily activity into the Windows Horse Farm 
Management program. 
 
1.  Set up your Company 

o Select “Setup” from the menu 
o Select the "Companies" menu item to open the form  
o Highlight the company name “Place Your Name HERE” and click the 

“Edit” button.  In the “Name” field, DELETE the words “Place Your 
Name HERE” and type in your own company/farm name.  Enter 
your address. Click the button “New” to enter your phone number, fax 
number, e-mail address, etc. and click “Save” when done. 

o Please note that you can set up more than one company if needed.  
For example, you may want to keep your Breeding stock in one 
company and your Sales stock in another separate company. 

o To add a new company select Setup > Companies and click the “Add” 
button.  In the “Name” field type in the name of the additional company 
and enter the address, the phone number, fax number, etc. and click 
“Save” when done. 

 

 
 



 

 
  Page 31 of 324

 
 

 
 

TIP: If your company logo is available, you can Click the “New” button 
and browse for your logo and then click the box “Show on Invoice”.   
Your logo will then print out in the heading on the top, right-hand 
side of your client invoices.  To remove the logo, click the “Remove” 
button in the Logo area on the Company Entry/Edit screen. 

o G/L Account. This is not a required field.   If you do not need to identify 
a specific G/L Account number for your farm, you can leave this field 
blank. 
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2.  Set up farms 

o Select “Master Files” from the menu 
o Select the "Farms" menu item  
o Click the “Add” button.  First, add your own farm 

 

 
 

o Add any other farms or facilities that you will be interacting with during 
the breeding season or throughout the year.  Enter as much 
information as you can, including the main phone number, contacts, 
Veterinarian Name/Number and any Breeding Requirements. 

o Other farms would include those that you send your mare to for 
breeding. Add any other farms that you will be interacting with during 
the breeding season.  Other “Farm” entries could include the stallion 
farm where your mare will be sent for breeding or the name of a clinic 
where you might send horses for veterinary services or the name of 
the track where your horse is currently in training. 

 
 
3. Review and Select Preferences 

o Select “Setup” from the menu 
o Select the “Preferences" menu item to open the form  
o Select “Company Settings” 
o Select the default breed from the drop down list 
o Select your own farm name from the drop down list as the “Default 

Farm”  
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o It is important to make note of the Location and name of the Save 

Folder.  This folder will hold all of the saved invoices from the closed 
billing periods and it should be backed up on a regular basis. 

 
Application Settings 
 

 
  
o If you want to be able to type horse names in lower case and let the 

system automatically convert them to uppercase, check the box next to 
“Capitalize All Horse Names” 
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Mare/Foal Settings 
 

 
 

o Days Between Last Day Bred and Foaling Date.  This number is pre-
populated but can be changed. This is the number used to calculate 
the Projected Foaling Date which shows up on the Mares Bred 
Summary Report, the Foaling Mares By Location Report and the Due 
Date which can be found on the Teasing Worksheet. 

o New Foal Naming.  When a new foal is entered into the system via the 
Mare Entry/Edit > Foaling Info you can select how the name will 
appear.  You can select to default the new foal’s name to be the Mare 
Name first and then the Season Year (Blackeyed Susan 12), or the 
Season Year first and then the Mare Name (12 Blackeyed Susan). 

o Disregard the “Stallion Mare” preferences unless you have purchased 
the HFM Stallion Module. 
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Billing Settings 
 

 
 

 Print Company Name on Invoices 
o If you want your name, address, etc. to automatically appear as the 

heading on your invoices, leave the “” marked in the box.  If you are 
using pre-printed stationery and do not want the system to 
automatically generate the heading, simply un-check the box next to 
Print Company Name on Invoice to remove the “”. 

 
 Print Board Descriptions on Invoice 

o Invoices usually show “Board @ $xx.xx per day”.  If the Print Board 
Type Description On Invoice is checked, the invoice will show “Sales 
Prep @ $xx.xx per day”. 

 
 Check for Duplicate Procedures 

o This option will warn you if you have entered a duplicate item within the 
same entry set 

 
Disable the Warning When Removing A Billing Option On Procedure 
Detail 
o If you DO NOT want the system to warn you that you have removed a 

procedure from invoicing, check the box next to “Disable the Warning 
When Removing A Billing Option On Procedure Detail”. 

 
Tax Name 
o For Non-US clients, enter the tax name that will be used in billing (such 

as HST, GST, etc.). 
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Display Auto-Allocation Options 
o When this box is checked, options will be displayed to help automate 

the process of applying credit invoices and unapplied payments to 
outstanding invoices. 
 

 
Billing Settings > Standard 
 

 
 
o Default Standard Service Charge. Select the default service charge 

from the drop down menu. This will auto-populate in the service charge 
field on the client master file each time a new client is added to the 
program. 

o Standard Billing Starting Invoice #.  This is the default number that will 
be used as the first number on your first invoice generated through the 
billing menu. This number can be changed but it has to be a number 
that is greater than any currently created invoices. 

o Summarize Invoice History Details.  If checked, the invoice will be 
shown in summary format. If unchecked the invoice will be shown in 
detail format. 

o Show Horse Charge Details on Invoice.  If checked, the invoice will 
print the detail page for all of the horse charges.  If unchecked the 
details will not be printed. 

o Show Procedure Summary on Invoice. If checked, the invoice will print 
the charges by category page.  If unchecked there will be no summary 
page printed. 

o Use double window envelope. If checked, the invoice heading will be 
shifted so that the address shows through a standard double window 
envelope. 
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o Standard Billing Invoice Comments.  Enter any information in this area 
that you want to appear on client invoices such as: Net 30, Payable 
Upon Receipt or Happy Holidays. The text that is entered here will 
appear on the first page of all client invoices. 

 
 
User Settings 
 

 
 
o If you want your reports to print to the screen first before printing to a 

printer, check the box next to “Default All Reports To The Screen” 
o Each person can select his/her own Required Field Color and the 

Alternate Required Field Color from the drop down list. 
o Show reports with formatting bands.  If checked, all reports will display 

formatting bands.  If unchecked there will be no formatting bands on 
any of the reports. 
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Email Settings 
 

 
 
Please contact The Jockey Club (800) 333-1778 or (859) 224-2800 for 
detailed instructions on the Email Settings. 
 

 
 

4. Set Up Clients 
           Select “Master Files” from the menu. 

o Select the "Client" menu item 
o Click the “Add” button to add each horse owner, client, billing 

entity, etc. to the system. 
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o First add yourself as a client. 
o Next, enter all of your clients.  You can enter just the last name and 

first name and leave the Farm/Company name blank or you can 
enter just the farm name or you can enter the last name, first name 
and the farm name.   Enter as much information on each client as 
possible. 

o When assigning ownership for horses you will be selecting clients 
from the Client Table that you have created. 

   
Tax ID:  This area is more for your reference and will only appear on the 
Client Listing Report.  It provides a place to note the Social Security 
Number of the client or the Federal ID Number of the company that has 
been entered on this screen. 
 
Service Charge Setup: Service charges are applied on an individual 
basis. If you want the system to automatically calculate service charges 
for a particular client, select the appropriate service charge code from the 
drop down list. 

 
 
Miscellaneous: 

Business Owner: This check-box is for your visual reference.  If checked, 
it indicates to you that the person listed (Last name, First name), owns the 
Farm/Company that has been entered on this screen. 

 
Use Farm/Company Name Only.  If the farm is the billing entity and not 
the client name, then check the “Use Farm/Company Name Only” box and 
only the farm/company name will appear on the invoices and reports.   
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Active:  When this box is checked it indicates that the client is Active.  If 
you uncheck the box the client will become Inactive. 
 
Suppress Billing always defaults “Blank”.  This means that the system 
will automatically keep track of all charges for this client and that the 
system will generate an invoice for this client.  If you check the box, this 
client’s billing becomes suppressed and no invoice will be generated. 
 
Exempt Code:  If you are using the Service Tax options and have set up 
the Service Taxes and the Tax Name (HST, GST, etc.) you will use this 
field to enter an Exempt Code for those clients that are not eligible to be 
charged a Service Tax. 
 
Invoice Distribution Method.  The default for this field is “Standard”.  If 
you wish for a client to receive invoices via E-mail, select “Email” from the 
drop down list. 
 

 
Note:  The Client Comments area is for your reference. These                   
comments do not print on any report. 
 
Note:  The Saved Documents area is a place that allows you to save copies 
of photos, scanned documents, videos, etc. directly into HFM.  Any file that is 
on your computer can be added to this area. 

 
 

 
Additional Client Entry/Edit Screen Options 
 
Mailing Codes:  One or several mailing codes can be assigned to each client.  If 
a mailing code is assigned, you will be able to print labels based on any of the 
pre-defined mailing codes.  You can add as many Mailing Codes to each client 
as needed. 
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To select a new mailing code for the client, click the button “New”, highlight the 
Mailing Code you want to add to the client and click “Select”.   
 

 
 
 

 
 
 
 



 

 
  Page 42 of 324

 
 
You can add as many Mailing Codes to each client as needed. 
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To populate the Mailing Code List, go to Setup > Master Lists and select “Mailing 
Code” from the drop down category list.  Click on “New” and enter each item that 
you want to include in the Mailing Code list. 
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Billing Info:  This is a look-up screen only.  It will show all current activity for that 
particular client. 
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Payments:  Receipts for a client can be entered or edited from the Client 
Screen.  To enter a new payment, click the button “New”. To look at an 
existing Payment, highlight the entry and click “Edit”. 
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 Adjustments:  Adjustments can be entered or edited from the Client Screen.  To 
add a new adjustment, click the button “New”.  To look at an existing Adjustment, 
highlight the entry and click “Edit”. 
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Horses:  This is a look-up screen only.  It will display all of the horses for 
which this client has ownership. You can select to view either currently 
boarding horses or all horses.   
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Other Addresses:  This screen provides a place to store any additional 
addresses for this client.  Select “New” when entering a new address and 
then select the desired item from the “Category” drop down list.  
 

 
 

 
 
.  Note:  If you select the category of “Billing”, the system will use this 

address for this client’s invoices instead of the address entered on 
the Client info. page.  All other categories serve only to store the 
additional addresses. 
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If you have entered any additional addresses for a client, the “Other 
Addresses” tab will reflect the number of additional addresses that have 
been entered.   

 

 
 
 
TIP: You can enter a client’s street or P.O. Box, skip the city and state, 

enter the zip code and the system will automatically enter the city and 
state for you. 

 
TIP: If you select a foreign country, the country code for that country will 

automatically appear above the main phone number. 
 
TIP: When entering phone numbers, type in the number without spaces or 

dashes and the system will automatically format it for you. For 
example, 8592242800 = (859) 224-2800. 

 
TIP: Enter any additional phone numbers for each client in the Phone/E-

Mail Entries area (fax, home, cellular etc.).  Click the button “New” 
and simply select the type from the drop down list. 
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5. Set up Boarding Types 
Select “Master Files” from the menu 
Select “Boarding Types” from the menu  

Add a “Boarding Type” for each type of horse you have on your 
farm and the daily rate you will be charging for each Boarding type. 
The board type is used for billing and the daily rate is the amount a 
horse will be charged per day to board with you. (Mare, Mare under 
lights, Barren mare, Mare pasture board, Foal, Weanling, Yearling, 
Sales Prep, etc.) 

 

 
 

 
 
o [Optional] Although not required, the system allows you to identify a 

Debit G/L Account for each Boarding Type. If each horse type has a 
unique G/L Account Number, the system will summarize the boarding 
charges for each Board Type at Month End Billing. 

o [Optional]  Comments entered in the “Boarding Type Comments” field 
will appear on the Horse Type Listing report (Reports> Base 
Reports>Boarding Type Listing) 
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6.  Set up Horse Types 

      Select “Master Files” from the men 
      Select “Horse Types” from the menu 
      Click “New” to add each Horse Type 
 

  
 
Note:  Similar Boarding Types can be grouped together in one Horse Type 
making it easier to produce lists or perform mass procedures. For example, you 
may have Mare, Mare Under Lights, Barren Mare or Mare Pasture Board but 
they are all “Mares”.  If you have a Horse Type of “Mare”, you can associate all of 
the other “Mare Boarding Types” to the Horse Type of “Mare” making it much 
easier to perform mass procedures on a particular Horse Type which includes 
several Boarding Types as well as making it easier to produce reports for one 
particular Horse Type which may include several Boarding Types. 
 

 
 



 

 
  Page 52 of 324

7.  Set up Procedure Categories  
Each specific procedure that is performed on a horse falls into a general 
“Procedure Category”. This allows procedure category totals to appear on 
your clients’ invoices (i.e. Total Vaccination Charges, Total Blacksmith 
Charges, etc.) 
 

o Select “Master Files” from the menu 
o Select  "Procedure Categories" menu item 
o Click “Add” to add each Category 
o Enter a category name.  It should be a general, descriptive 

name such as Blacksmith, De-worming, Vaccinations, Medical, 
Nominations/Registration, Tack & Equipment, Vanning, etc.  

 

 
 

o Select whether or not you want items in this category to print on 
your departure form (No, Yes, Last). If you select “No”, the 
procedures that have been performed in this category will not 
print on the departure form, if you select “Yes”, the procedures 
that have been performed in this category will print on the 
departure form.  If you select “Last”, only the last occurrence of 
the procedures that have been performed in this category will 
print on the departure form. 

o [Optional] Select an appropriate billing category. 
o [Optional] Enter a G/L Account number for this category.  If a 

unique G/L Account number is assigned to each category, the 
system will summarize charges for each category at Month End 
Billing. 

 
Note:  The “Procedure Category Comments” area is for your reference.  These                   
comments do not print on any report. 
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8.  Set up Procedure Masters 
 

o Select  “Master Files” from the menu. 
o Select  "Procedure Masters" menu item 
o Click “Add” to add each individual procedure 
o Procedure Name:  Enter the name of each specific procedure that 

may be performed on a horse on a regular basis such as Rabies 
Vaccination, New Halter, Deworm – Strongid, Palpation, 
Ultrasound, Trim 4, Jockey Club Registration, IgG, Biopsy, Bute 
Paste, CF Blood, Infuse – Gentocin, etc. 

 

 
 

o Default Unit Charge:  Enter the Standard Charge for each 
procedure.  If there is no standard charge you cannot leave the field 
blank, you must enter -0-. 

o Procedure Category:  Select the corresponding Procedure 
Category for that procedure from the drop down list. 

o Default Teasing Chart Results:  Works in conjunction with the 
“Results on Teasing Chart” option.  For example, “P” could be used 
on the teasing chart to indicate when the mare was Palped, “U” 
could be used on the teasing chart to indicate when the mare had 
an Ultrasound, “B” could be used on the teasing chart to indicate 
when the mare was bred.  The Teasing Chart Results field is limited 
to 3 characters. 
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o Unit Type:  Select the Unit Type for this procedure from the drop 
down list. 

 

 
 
o Default Performed by:  If this particular procedure is normally 

performed by a specific vet or company or blacksmith, select the 
person/company from the drop down list and the Default Performed 
By will auto populate on the procedure entry/edit screen. 

o Departure Print:  Select whether or not this procedure will print on 
your Departure Form (No, Yes, Last).  If left blank, it will default to 
whatever you selected when you set up the Procedure Category.  
Whatever is selected in the Procedure Master Entry/Edit form will 
take precedence over what is entered in the Procedure Category 
Entry/Edit form. 

o Default to Appear on Invoice: All Procedure Masters will default to 
appear on the client invoice.  If you want to record a procedure for a 
horse but want it to always default to NOT print on the invoice, 
uncheck the box. 

o  [Optional]  Override G/L Acct:  You can enter a General Ledger 
Account number for this specific procedure that will override the 
General Ledger Account number in the Procedure Category 
Entry/Edit screen.  For example, you might set up the category 
“Vaccinations” with a General Ledger number of 3000.  Procedures 
that fall within that category such as Rabies Vaccination would 
have an Override G/L Account Number of 3000.10, Tetanus 
vaccination would be 3000.11, Strangles vaccination would be 
3000.12, etc. 
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Procedure Types 
 

 
 
o [Optional] Health Type:  When entering procedures you can mark 

any number of procedures as “Health Type”.  If marked as a Health 
Type, you will have the option to show only records that are a 
“Health Type” when you print a horse’s Health Record 
(Reports>Misc. Reports>Health Record).  For example, you might 
mark the procedure “Rabies    Vaccination” as a Health Type but 
you would not mark the procedure “Vanning” or “Neck Strap” as a 
“Health Type”. 
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o [Optional]  Movement/Transfer Procedure:  If a procedure is 
marked as the “Movement/Transfer Procedure”, additional fields will 
be available for input on the Procedure Entry/Edit screen.  When 
entering this procedure for a horse you will be able to change the 
Farm, Location, Barn, Stall and Field from the Procedure Entry/Edit 
screen and this information will automatically be updated in the 
horse’s master file. 

 

 
 

 
o [Optional]  Update Mare Exam Status:  If a procedure is marked to  

“Update Mare Exam Status”, additional fields will be available for 
input on the Procedure Entry/Edit screen.  When entering this 
particular procedure for a horse you will be able to enter the 
Pregnancy Exam Status (Status After Exam). This information will 
automatically update the “Status After Exam” field in the Mare 
Information screen. 
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  Page 58 of 324

 
 

 
o [Optional]  Foaling:  Enter a procedure called “Foaling or Foaling 

Date or Foaled” and check the box “Foaling”.  This will enable the 
system to automatically create a procedure in the mare’s health 
record showing the foaling information that has been entered in the 
Mare Information Screen > Foaling Info Tab.  Often the master 
procedure “Foaling Fee” is marked as the Foaling procedure 
eliminating the need to manually enter the foaling fee.  This 
procedure will also automatically appear on the client’s invoice.   

 
o You can have only one procedure marked as your Foaling 

Procedure. 



 

 
  Page 59 of 324

 
 
 

o  [Optional]  Recurring:  A procedure such as Regumate, SMZ Tabs, 
Vitamins/Supplements, Bute, etc. would be examples of Recurring 
procedures.  If a procedure is marked as Recurring you will be able 
to enter the beginning date of a procedure and an ending date. If 
the procedure will be ongoing, the end date can be left blank (as in 
Regumate daily). 
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o [Optional] Breeding:  Enter a procedure called “Bred or Breeding or 
Breeding Dates” and check the box “Breeding”.  This will enable the 
system to automatically create a procedure in the horse’s health 
record stating that the mare was bred to a particular stallion on a 
particular day.  This procedure will also automatically appear on the 
client’s invoice.   
o You can have only one procedure marked as your Breeding 

Procedure 
 

o [Optional]  Results on Teasing Chart:  If a procedure is marked to 
have “Results on Teasing Chart”, additional fields will be available 
for input on the Procedure Entry/Edit screen.  When entering this 
procedure for a horse you will be able to enter information for LO 
(Left Ovary), RO (Right Ovary), Cervix and Other.  This information 
will automatically appear on the Teasing Chart. The Results fields 
are limited to 3 characters. 
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o [Optional] Coggins: If there is a procedure marked “Coggins”, the field 
“Last Coggins” on the horse master file entry/edit screen will automatically 
be updated with the date that the coggins was last performed. 
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o [Optional] Arrival/Depart Procedure: Enter a procedure called 
Arrival/Departure” and check the box “Arrival/Depart Procedure”. This will 
allow the system to automatically create a procedure in the horse’s health 
record stating that the horse arrived on a particular date from a particular 
place and/or departed on a particular date and shipped to a particular 
place.  This automatic entry will take place when you enter an arrival or 
departure date in the Horse Entry/Edit > Boarding page. 

o You can have only one procedure marked as your Arrival/Depart 
Procedure 

 

 
 



 

 
  Page 63 of 324

 
 

o [Optional]  Date of Birth:  If a master procedure is marked as the “Date of 
Birth” procedure it will enable the system to automatically create a 
procedure in the foal’s health record indicating that the foal was born and 
it will include any foaling information that was entered on the Mare 
Information Screen > Foaling Info Tab.  Often the master procedure “Foal 
Date of Birth” is marked as the Date of Birth procedure eliminating the 
need to manually enter a procedure to record the foal’s date of birth.   

 

 
 

o This automatic entry will take place when you enter foaling information in 
the Mare Entry/Edit > Foaling Info tab and click  “Add Foal as New Horse” 

 
o You can have only one procedure marked as your Date of Birth Procedure 
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Note: The “Proc Master Comments” area is for your reference.  These                   
comments do not print on any report. 

 
Note:  After you have finished setting up the program, you will be entering all 
of the daily procedures that have actually been performed on your horses.  At 
that time, you will be selecting one of these procedures from a master listing 
on the procedure detail screen. 
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9.  Horse Entry 

 
o Select “Master Files” from the menu. 
o Select “Horses” menu item  
o Select “Add” to add each horse to the system. 

 

 
 

o Enter the horse’s name. 
o Select the Breed (if you have Default Breed selected in the 

Preferences section this will be added automatically). 
o The default farm (yours) will be added automatically. 
o Enter all of the basic information about this horse. 
o Next, you must assign an owner to this horse. 

 
TIP:  The “Horse Comments” field on the Horse Entry/Edit form is for 
your reference and does not appear on any report. 

 
TIP:  Expected Arrival Date on the Horse Form is the date that you 
Expect the horse to arrive on your farm – NOT the actual arrival date.  
This field is optional and can be left blank. 

 
TIP:  Expected Departure Date on the Horse Form is the date that you 
Expect the horse to depart from your farm – NOT the actual departure 
date.  This field is optional and can be left blank. 
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TIP:  If you type a comment in the Departure Notice field, that comment 
will appear on your departure form. 
When adding a horse to the system, you are required to identify the 
owner of the horse for billing purposes.  
 
While you are still on the "Horse Entry/Edit: screen… 

o Click on the "Ownership" tab 
 

o Click “New Date” (this is usually the day that the horse arrived on 
your farm). (A) 

 

 
 
 

 
 

A 
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o Enter the ownership date and click “OK” 
o The Client Lookup screen will open after you have clicked “OK”. 

Find the current owner of the horse from the list and click the 
button “Select”. 
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o If more than one person owns the horse, click on the “New” button 
located under and to the right of the Owner section and select the 
next owner.  Each owner is entered on a separate line, so be sure 
to indicate the correct ownership percentages for each client. 
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o All board and procedure charges will be billed to owners of horses 
based on the percent of ownership. Note:  Total Percent Owned 
must always equal 100% 

 
TIP:  Ownership Dates:  The system will store all ownership changes 
and will process billing based on any combination of ownership 
percentages.  When ownership changes, click on the “New Date” 
button and enter the date the new ownership takes effect and then 
select the new owner(s) from your client master list.  Do not delete 
prior ownership dates/clients when adding new ownership. 
 
TIP: Exception Board Rate:  If the owner(s) is to be charged a 
boarding rate different from what you have established as standard, 
enter that rate in the Exception Board Rate column.  For example, if 
your standard rate for a mare is $18.00 per day and you want to 
charge a client $15.00 per day, enter $15.00 in the Exception Board  
Rate column.  If you don’t want to charge a client anything for board, 
enter $0.00 in the Exception Board Rate column.  If your standard 
rate is $18.00 per day and you want to charge a client $22.00 per 
day, then enter $22.00 in the Exception Board Rate column, etc. 
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TIP: Exception Procedure %:  If there is more than one owner and 
you would like to charge a fixed percentage of all procedures to one 
owner and a fixed % to the other owner(s), you can enter that 
procedure exception percent in the field provided.  Procedure 
Exception % must add up to 100%.   
 

 After you have entered the ownership for the horse, you must let the 
system know that the horse has arrived on your farm if you want the 
system to calculate the daily boarding charges.   

 
o Click the "Boarding" tab to open the Arrival / Departure / Boarding 

screen. 

 
 

o Click the button “New Arrival”, enter the arrival date and click 
“OK”. 

o Select the “Vanned by” 
o Select the “Arrived From”  
o Select a “Boarding Type” from the drop down list  
o Daily board charges for each horse will begin accumulating based 

on the arrival/departure date.   Horses will be charged board “day 
in” and “day out”. 
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TIP: Exception Rate:  If the owner (s) is to be charged a boarding 
rate different from what you have established as standard, enter that 
rate in the Exception Rate field above the Standard Rate.  An 
Exception Rate entered on the Boarding screen will cause the 
system to charge the exception rate only when the horse is at this 
specific “Boarding Type”.  If a horse is “Broodmare” with the 
exception rate of $10.00 and then changes to “Sales Prep”, the 
owner will be charged the standard rate for “Sales Prep” and the 
Exception Rate for “Broodmare” will no longer apply.   
 
TIP:  If you have entered an Exception Rate in the Ownership screen 
(Exception Board Rate) and an Exception Rate in the Boarding 
screen, the Ownership Exception Board Rate will be the controlling 
rate. 
 
TIP:  The Boarding screen will store all of the history of the horse’s 
arrivals and departures and board type changes.  When making a 
new entry, do not type over or remove the existing dates. Always 
click “New Departure”, “New Arrival” or “Change Boarding”. 
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TIP:  The “Boarding Comments” field on the Boarding form is for your 
reference and does not appear on any report. 

 

 
 
TIP:  The system will charge one day’s board on the day the horse  
arrives on the farm and will continue through the day the horse 
departs the farm (inclusive). 
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Additional Options on the Horse Master Entry/Edit Screen 
 
o Insurance – Click the button “New” and enter and store current 

insurance information on each horse (Insurance Company, 
Contact, Phone, Fax, Policy Number, Coverage, etc.) 

 

 
 
o Procedures – Enter or edit procedures that have been performed 

to this horse either from here or from the Procedures menu item. 
(Procedures > Procedures Performed) 

o Mare Info. – Click the button “New” to add new information or click 
the button “Edit” to view information that has already been 
entered. You can enter breeding information through this screen 
or through the Procedures menu item. (Mare Info > Mares) 

o Notes – Click the button “new” and enter additional information 
pertaining to this horse.  Enter a date, select the procedure from 
the drop down list, select the Performed By, Farm and then enter 
any additional comments in the Horse Notes Comments section. 
Information entered here will only appear on the Horse Notes 
Report (Reports > Misc. Reports > Horse Notes).  Information 
entered here does not appear on invoices.  The Notes screen can 
be used to enter horse markings, evaluations, workouts, etc. 
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o Sales – Store information on the sales history of this horse. Click 

the button “New” and add sale information. 
o Nominations – Enter and store information on what nominations 

have been submitted for this horse.   Click the “New” button and 
select a nomination from the list. 
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o Equineline – You can order Equineline reports directly from the 
Horse Entry/Edit screen. 
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o Verify button – This is a billable service.  When enabled it will 
verify the name, sex, color, Date of Birth and pedigree for this 
horse.  Please contact The Jockey Club directly to purchase this 
feature. 
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o Saved Documents – This is an area where documents relating to 
this horse can be saved.  Click the “Add” button and then click the 
“Browse” button to browse for the file.  Enter the Name for the 
document and click “OK” when finished. 
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10.  Review Master Lists [optional] 
No changes are needed unless your farm uses a different set of terms 
Select “Setup” from the menu 
Select “Master Lists” 
Select the list category that you wish to review.  This displays the list of 
user choices for that category.  Example:  Address Category 
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You should just review the categories and not make changes at this time.  
If your farm needs additional items than those that are shown, they can be 
added by clicking the button “New”  See (A)   
 

A
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When you click the “New” button, a new, blank line will appear in the list. 
Type the new entry in the new blank line and then click “Save”. 
 
 
 



 

 
  Page 81 of 324

 
 
Note:  If you select the Category of “Mare Status”, you will see that the 
system has defined several of the items as “True”. The system requires 
these specific items to be used exactly as they are shown in order for the 
associated reports to be correct and will not allow you to change or delete 
these items.  If you select an item marked as “True” you will see that the 
button “Remove” is not active, thus you cannot change or remove any 
item marked as “True” 
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11.  Review Billing Setup [optional] 
(Setup > Billing Setup) 
 

 
 
Since the Horse Farm Management System uses General Ledger Account 
numbers to allocate charges and payments appropriately, G/L Account 
numbers should be identified prior to using the system.  
 
Note: The system has been preloaded with all necessary G/L codes.  

Only if your farm uses specific G/L accounting codes will you need  
 to change the preloaded codes. 
 
Billing Codes 

o Select  “Setup” 
o Select  “Billing Setup”  
o Select  “Billing Codes” 
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The system is preloaded with a Default Debit and a Default Credit G/L 
Account number.  Unless you want to use specific G/L Account numbers, 
you do not need to do anything in these fields.   
 
You can leave the numbers that have been pre-loaded or you can enter 
account numbers designated by your farm. 
 
Note:  When you are entering your cash receipts on a daily/regular basis,  
you will be selecting this payment code from a drop down list.  Again, this 
payment application code indicates to the system that the cash receipt will 
be applied to your Standard (Board) billing. 
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Note:  Your “Month End Billing”, or “Board Billing” consists of boarding 
charges as well as procedure charges.  When a payment is made, you will 
not be separating the payments into “Board Payments” and “Procedure 
Payments”. 
   
TIP: Your Billing Application Code Default Debit Account can be either 

numerical or alphabetical.  
 
A/R Maintenance (New Users Only) 
 Select “Setup”  
 Select “Billing Setup”  
 Select “A/R Maintenance” 
 A list is displayed with all of the clients that you have entered into the 

system. 
 

 
 

 Add the ending balances for each client from your previous billing.  
(You can put the full amount in the current column or you may want to 
break down the amount owed into Current, Over 30, Over 60, Over 90 
and Service Charges in order for the Aged A/R Balance Reports to be 
correct.) 

 
Note:  The amounts entered in this table will be reflected as the beginning 
balance on the first billing run performed on HFM.  
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 Important: You can only edit A/R balances in this manner during your 

initial install/configuration process. Once you have Generated and 
Finalized a billing, you can no longer edit information on this page. 

 
 

  Service Charge [optional] 
 
If you charge late fees for unpaid invoices, you will enter codes for each 
rate you plan to use.  The Horse Farm Management System will 
automatically apply a “late fee” to any unpaid balances for those clients 
that you specifically indicate should be charged late fees/service charges.  
A client will never be charged late fees unless you specifically mark it as 
such. To set up the Service Charges/Late Fees: 
 
o Select “Setup”  
o Select “Billing Setup”  
o Select “Service Charge” 
o Click the button “New” to add each Service Charge 
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Each line can have a different Service Charge Code with different 
percentages.  Depending on your specific needs, you can enter just one 
service charge type or several.  Click the button “New” then enter the 
Service Charge Description and the rate in the 30, 60 & 90 columns.   
 

 
Service Tax 
(Setup > Billing Setup > Service Tax) 
Note:  This feature is used by international clients. It allows the entry of a 
service tax such as GST, HST, VAT, etc. to be charged on boarding and 
procedures. 

 
 Select “Setup” 
 Select “Billing Setup” 
 Select “Service Tax” 
 Click the button “Add” 
 Add the tax Name 
 Add the Rate 
 Add the G/L Account Number [optional] 
 Go to Setup > Preferences > Billing Settings and enter the Tax Name 

See (A) 
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A
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 Go to Master Files > Boarding Types and select the appropriate TAX 
name from the drop down list. 
 

 
 
 

 Go to Master Files > Procedure Master and select the appropriate TAX 
name from the drop down list.  
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When you enter a procedure for a horse that has been marked to have the 
Service Tax applied, the information will automatically populate on the procedure 
entry screen. 
 

 
 
If you do not want a client to be charged the Services Tax, enter the Exempt 
Code on their Client master page. See (A) 
 

 
 
 
 
 
 
 
 

A
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G/L Account Setup [optional] 
 
o Select “Setup” 
o Select “Billing Setup” 
o Select the “G/L Account Setup” 
 
 

 
 
Note: The system has been preloaded with all necessary G/L Account 

Numbers.  Only if your farm uses specific G/L accounting codes will 
you need to change the preloaded Account Numbers. 
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HEALTH RECORD ENTRIES 

Procedures 
 
1.  Adding Procedures That Have Been Performed on Horses 

Procedure Detail 
o Select “Procedures” from the menu. 
o Select the "Procedures Performed" menu item 

(You can also get to this screen by clicking the “Procedures” tab in the 
“Horse Entry/Edit” form)  

o Click on the horse name from the list and click  “Select” 
o To edit an existing procedure click on the procedure shown on the list 

and click “Edit” 
o To enter a new procedure click the button “Add” 
o Performed:  Enter the date that the procedure was performed 
o [Optional] You can enter the time that the procedure was performed by 

typing in the time on the same line as the date.  Entering a time will 
prompt the system to list procedures chronologically on the pre-billing 
report and on the invoices.  If no time is entered, the system lists 
procedures by date but in a random order. 

o Performed By:  Enter the name of the person that performed the 
procedure (Vet name, Blacksmith name, Farm Name, Farm Manager 
Name, etc.) or pick the name from the drop down list. 

o [Optional]  Invoice Ref. #:  Enter the invoice number. 
o Procedure:  Pick the name of the procedure that was performed from 

the drop down list. 
o [Optional] Override Description:  You can enter an “Override 

Description” for the procedure that was performed.  For instance, you 
might have “Blacksmith - Equilox” as the procedure and want to type in 
an Override as “Blacksmith – Equilox LF” See (A) 

o [Optional] Charge:  You can change the amount in the “Charge” field if 
the amount charged for the procedure is different than the standard 
charge that you have set up.  For example, the standard charge for  
Equilox was set up at $125.00 but in this particular case the blacksmith 
had to use additional time and materials on the hoof which increased 
the amount charged to $135.00.  You can highlight “$125.00” and type 
in $135.00 and the client’s invoice will now reflect the correct charge of 
$135.00.  See (B)   

 
o Or, if the Quantity is 1.00 you can, in many cases, change the quantity 

to another number and the charge field will automatically update to 
show the correct amount. 
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o Appear on Invoice?:  This box always defaults with a  in the box 
unless you have changed the default setting on the Procedure Master.  
When “Appear on Invoice?” is checked, it indicates that this procedure 
and the amount charged will appear on the client’s invoice.   

o If you un-check the box, this procedure and the associated charge will 
not appear on the client’s invoice. 

A

B 
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o [Optional]  Print Procedure Comments on invoice?  If checked, any 
comments that have been entered in the “Procedure Comments” area 
will appear on the client’s invoice. 

o [Optional]  Print Results on invoice?  If checked, any Results that have 
been entered in the “Results Details” area will appear on the client’s 
invoice. 

o [Optional] Procedure Comments:  Type in comments pertaining to the 
procedure that has been performed.  These comments will appear on 
the departure form and on the procedures performed report.  
Additionally, these comments will appear on the client’s invoice if the 
“Print Procedure Comments on Invoice” box has been checked.    

 
Charges 
o Unit Charge:  This is a read only field and will display the Unit Charge 

information that has been entered on the Procedure Master page. 
o Quantity:  This will default to “1.00”.  If the quantity number is changed 

the Charge will automatically be updated to reflect the corresponding 
amount. 

o Charge:  Defaults to whatever amount that has been set up in the 
Procedure Master page.  This charge can be changed on this screen if 
necessary. 

 
Results Details 
o [Optional] Results:  Enter any additional information regarding the 

procedure that has been performed.  This information will appear on 
the departure form, health record report and the procedures performed 
report. 

o [Optional] Received Date: Enter the date that you received the results.  
Information entered in the Received Date field does not appear on any 
report.  

 
Scheduling Details 
o [Optional]  Future Scheduling:  If you would like to schedule this 

specific procedure to be done again to this particular horse on a 
particular date in the future, enter the date in this field.  Procedures 
that are scheduled will be printed on the Scheduled Procedures Due 
Report (Procedures>Reports>Scheduled Procedure Due).  

o [Optional]   Scheduling Comments:  Enter any comments pertaining to 
the procedure that has been scheduled in the future.  These comments 
will appear on the Scheduled Procedure Due Report.   

 
 
Multiple Entries 
o To enter the same (or similar) procedures on multiple horses do the 

following: 
 Enter the first procedure as explained above.  
 Single-click the “Save/Add” button to save the current procedure 

and activate a new record. 
 Select the next Horse from the drop down horse list. 
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 Single-click the “Fill From Previous” button to populate all other 
fields with the previously entered data (Performed, Procedure, 
Performed By, Invoice Reference # and Charge). 

 Edit any of the fields that need to be changed and repeat these 
steps as needed. 

 
o To enter multiple procedures on a single horse do the following: 

 Enter the first procedure as explained above.  
 Single-click the “Save/Add” button to save the current procedure 

and activate a new record. 
 Single-click the “Fill From Previous” button to populate all other 

fields with the previously entered data. 
 Edit any of the fields that need to be changed and repeat these 

steps as needed. 
 

Editing Procedures 
When editing a procedure that has already been entered: 

 Select “Procedures” from the menu. 
 Select the "Procedures Performed" menu item 
 (You can also get to this screen by clicking the “Procedure 

Entry” tab in the “Horse Entry/Edit” form)  
 Find the horse name in the list and press “Select” or double click 

on the horse name that you want. 
 From the Procedures Detail screen select the procedure you 

want to edit and press “Edit” or double click on the selected 
procedure to open up the record. 
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You can Search By Procedure, by Procedure Performed Date or by 
Unbilled Procedures By Date 
 
 
 

 
 

 

 
 
 After editing the procedure, click “Save”. 

 
TIP:  All procedures automatically become part of the horse’s health 
record and the monthly billing.  All procedures entered will appear on the 
client’s invoices unless either the “Appear on Invoice” option was 
unchecked (on the Procedure Detail screen) or the "Suppress Billing" 
option was checked (on the Client Entry/Edit" form) for the owner of the 
horse. 
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2.  Adding Mass Procedure Entries 

o Select  “Procedures” from the menu. 
o Select “Mass Procedures” menu item 
 

 
 
o Click “New” to enter a new Mass Procedure or click on an 

existing Mass Procedure and click “Edit” if you want to view 
and/or edit an individual entry in an existing Mass Procedure. 
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o Click on “Boarding” to view a list of horses that are currently 

“Boarding” or click on “All” to view a list of the horses whether 
they are currently boarding or not and then click “Apply Filter” to 
see the horse list. 
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o To generate a Mass Procedure for one particular group of 

horses, select the Horse Type from the drop down list. 
 
o Click “Apply Filter”.  When you click “Apply Filter”, the system 

searches through the entire horse list shown and returns with 
only horses of the type you have selected. 

 

 
 
o If all horses shown in the Horse List are to be included in the 

Mass Procedure, click the third arrow from the top (this arrow 
points to the right and has a “shadow”) See (A) Clicking on that 
particular arrow will select all of the horses in the list to be 
included in the mass procedure. 

A 
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o When the horses in Mass Group List (box on the right) correctly 
shows all of the horses you want to include in the mass 
procedure, click “Next”    
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o On the next page (Mass Procedure Details) select the 
procedure that was performed from the drop down list. 

o [Optional]  Enter an override description. 
o Enter the date on which the procedure was performed. 
o [Optional]  Enter who performed the procedure. 
o [Optional]  Enter the Invoice Number. 
o Unit Charge is the standard charge that you originally set up. It 

is a read only field and cannot be changed. 
o Quantity defaults to “1” – change the quantity only as 

necessary. 
o Charge is the standard charge that you originally set up – 

change the dollar amount only as necessary. 
o [Optional]  Enter any comment regarding this procedure.  This 

comment will appear on the Procedures Performed Listing and 
Health Record Report. 

o [Optional]    If you want the comments to appear on your 
invoices, click in the box “Print Comments on Invoices”. 

o Click “Finish” 
 

 
 

o System will prompt you if you want to continue or not. 
o Click “Yes” and the System will give you the message that the 

Procedures have been saved. 



 

 
  Page 101 of 324

 
 

o Click “Ok” and the Mass Procedure Worksheet will appear on 
the screen.   

 

 
 

o Print the worksheet for your reference or close the report and 
click “Close” to close the Mass Procedure Entry screen. 

 
3.  Editing Mass Procedures 

o Select  “Procedures” from the menu. 
o Select “Mass Procedures” menu item 
 



 

 
  Page 102 of 324

 
 
o Select the Mass Procedure that you want to edit and click “Edit”. 
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o When you click “Edit”, the list of all horses included in the Mass 
Procedure will open.  From here you can select any individual 
horse name and view and/or edit just one horse’s record at a 
time. 

 

 
 
o Once you have selected a horse and have opened up the 

Procedure Detail Edit screen, you will be able to make any 
necessary changes to this record providing it has not been 
included in a closed billing.   

o The procedure can also be changed/edited through Procedures 
Performed. 

 
NOTE:  The Mass Procedure edit screen will display Mass 
Procedures for one year from the current date.  The procedures 
that have been created will always be shown in the Procedures 
Performed and can always be accessed via the same.
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4.  Deleting a Mass Procedure 

o Select  “Procedures” from the menu. 
o Select “Mass Procedures” menu item 
o Select the Mass Procedure that you want to delete and click 

“Remove”.    
 

 
 
o When you select “Delete”, that specific procedure is deleted 

from all horses that had been included in that specific Mass 
Procedure. 

o If you want to delete just one horse from the “Mass Procedure”, 
select the specific mass procedure and click “Edit”.  All of the 
horses in that mass procedure will be displayed.  Find the one 
horse’s name, click on the name and click “Remove”. 
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5.  Scheduling Procedures to be Performed 
o Select “Procedures” from the menu. 
o Select “Schedule Master” menu item. 

 
o Click  “Add” to schedule a new procedure 
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NOTE:  Scheduling a procedure will not add a procedure to the system. If you 
want the procedure to show up in the horse’s health record, you will have to 
indicate that the scheduled procedure has been performed via the Procedure 
Performed Entry screen. 
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6.  Schedule Master Samples 
 

o To schedule one specific procedure to take place on one 
specific day on one particular horse, select the following: 

o Schedule Name:  Enter a name for the Scheduled 
Procedure 

o Procedure:  Select the procedure that is to be scheduled 
o Horse:  Select correct horse name from the drop down 

list 
o Schedule the Procedure:  Select “one time” from the drop 

down list and enter the date that the procedure is 
scheduled to be done. 

 

 
 

o This will schedule an insurance exam to be performed on the 
horse “Evening Primrose” on April 25, 2011. 
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o To schedule a procedure to take place once per month for a 

particular horse type, select the following: 
o Schedule Name:  Enter a name for the Scheduled 

Procedure (Example:  Monthly Trim - Mares) 
o Procedure:  Select the procedure that is to be scheduled 

(Example: Trim 4) 
o Horse Type:   (Example: Mare) 
o Procedure:     (Example - Trim 4) 
o Schedule the procedure (30) (Days) (after the) 

(procedure) (Trim 4) has occurred.  OR 
o Schedule the procedure (1) (Month) (after the) 

(procedure) (Trim 4) has occurred. 
o Create new scheduled procedures starting on (Example: 

04/26/10) 
 

 
 

o This will schedule all of the horses with the Horse Type of 
“Mares” to get trimmed every 30 days beginning on April 26, 
2010. 
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o This will schedule all Mares to get trimmed every month on the 
26th of each month beginning April 26, 2010 

 
o To schedule a specific procedure to take place after a given 

number of days has passed since an initial procedure was 
performed, select the following: 

o Schedule Name:  Enter a name for the Scheduled 
Procedure (Example:  Foals – 10 Day Tetanus) 

o Procedure:  Select the procedure that is to be scheduled 
(Example: Tetanus) 

o Schedule the procedure (10) (Day) (after the) (procedure) 
(Foal Date of Birth) has occurred. 
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o This will schedule all foals to have a Tetanus performed 10 days 
after the procedure of “Foal Date of Birth” has been entered into 
the system. 

o  This type of scheduling is particularly helpful when you need to 
schedule procedures based on the event of “Foal Date of Birth” 
since the dates that these procedures are performed can be 
different for each individual in the group.  

 
Note:  You can also schedule procedures to be performed based on other 
scheduled procedures. 
 

 
 

o This is an advanced feature and we recommend that you call The Jockey 
Club directly (800) 333-1778 or (859) 224-2800 to get detailed information 
on how to set up advanced “Scheduling Chains”. 
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o While you are on the “Procedure Detail” screen you can schedule the 
same procedure to be done to the same horse on a particular day in the 
future. 

o Select “Procedures” 
o Select “Procedure Performed” 
o Select the horse and the procedure that was performed 
o Enter a date for future scheduling and any comments 

pertaining to the procedure to be done. 
 

 
 

o This example shows that the horse “Evening Primrose” 
had the procedure “X-Ray” done on 04/27/10 and is 
scheduled to have another “X-Ray” done on 05/11/10.   

 

 
The Scheduling Comments from the procedure detail screen will appear on the 
Scheduled Procedures Due report. 
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Procedure Reports 
 

 
 
 
 
1. Procedures Performed Report 
 

 
 
Prints a report of the procedures that have been performed based on the criteria 
selected.   
 
You can select any date range, sort the report by Performed Date, Horse Name, 
Order Entered, search either in the Performed Date or the Entered Date, select 
horses that are boarding or not or with activity or not.   
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You can also select by the “Farm”, “Horse”, “Location”, “User ID”, “Invoice Ref 
No”, “Barn”, “Horse Type”, “Band/Tag”, one “Procedure” or several, one 
“Category” or several, “Performed By” or  “Current Owner” field.  The report will 
show amounts charged and totals based on what you have selected to print. 
 

  
 

 
 

TIP:  To select more than one procedure for the Procedures Performed 
Report, simply click in the box to the right of the procedure to select all of 
the procedures you want to include on your report.  Follow the same steps 
to select more than one Category. 

 
 

TIP:  To print a report to double-check your day’s entries, enter “today’s 
date” in the Starting Date and Ending Date and search in “Entered Date”.  
Next, Sort By “Ordered Entered” and submit the report either to the printer 
or the screen.  This report will show you all of the procedures that have 
been entered for that particular day in the order that you actually entered 
them. 
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2. Procedure Category Listing 
 
This menu item prints an alphabetical list of the categories that have been 
entered into the system. 

 
 
When printing this report you can choose to show those Categories that have 
been marked as “Inactive” or not. 
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3. Procedure Master Listing 

 
This menu item prints a list of the master procedures that have been entered into 
the system.  You can either sort the list by category or not and you can choose to 
show those Master Procedures that have been marked as “Inactive” or not. 
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4. Schedule Master Report 
This menu item prints a list of all of the scheduled procedures that have been 
entered into the system. 
 

 
 

 



 

 
  Page 118 of 324

 
5. Scheduled Procedures Due Report 
 

o Select “Procedures” from the menu 
o Select “Procedure Reports” from the menu 
o Select “Scheduled Procedures Due” menu item 

 

 
 

o Select a date range to print.  You might want to see what 
procedures have been scheduled for one day, one week, one 
month or even one year.   

 
o Once you have selected a date range, you have the option to 

further limit the report by selecting other criteria. 
 If you want to see everything that is scheduled for “In-Foal” 

mares only, check the box next to “Only In-Foal Mares?” and 
leave the other fields blank. 

 If you want to see everything that is scheduled for all horses 
on one particular farm, select the specific farm name from 
the drop down list and leave the other fields blank. 

 If you want to see everything that is scheduled for one 
particular horse, select the one horse’s name from the drop 
down list and leave the other fields blank. 

 If you want to see everything that is scheduled for one 
particular horse type, select that particular horse type from 
the drop down list and leave the other fields blank. 

 If you want to see all horses that have been scheduled for a 
particular procedure, select the specific procedure from the 
drop down list and leave the other fields blank. 

 If you want to see all horses that have been scheduled for all 
procedures in a particular category, select the specific 
category from the drop down list and leave the other fields 
blank. 
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 If you want to see all horses of one horse type that have 

been scheduled for a particular procedure, first select the 
specific horse type from the drop down list and then select 
the specific procedure from the drop down list and leave the 
other fields blank. 

 
Note: The Schedule Procedures Due Report will provide you with a list of what 
should be done to your horses based on what has been entered in the Schedule 
Master screen.  Because it has been scheduled does not mean that the 
procedure has actually been performed on a horse or a group of horses. 
 
 
NOTE:  When the due date in the Schedule Master screen has passed for a 
scheduled procedure, that scheduled procedure will appear as (Past Due) 
on the procedure Detail screen and (Over Due) on the Scheduled 
Procedures Due Report. 
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MAINTAINING CLIENT BALANCES 

A/R Transactions 

 
 
1. Adding Payments 

o Select “A/R Transactions” from the menu 
o Select the “Payments” menu item  
o Select the name of the client that has made a payment 

 
o Either double click on the name or click once on the name and then 

click “Select” 
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o Click “Add” to enter a new payment (or “Edit” to change an existing 
entry if it has not yet been finalized in a billing). 
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o Date Received:  Enter the date that the payment was received (you 
can type in the date or click the “down arrow” to select the date from 
the calendar) 

o Applied To:  Select “Standard” from the drop down list or whatever 
Billing Application Code you have set up for Standard/Monthly billing in 
the “Applied To” field 

o Check Number:  Enter the check number 
o Amount:  Enter the amount of the payment 
o Show Comments On Invoice?:  [Optional] Click this box if you want the 

payment comments to show up on the invoice. 
o Payment Comments:  Enter any further comments regarding this 

payment. These comments will appear on the Receipts Report.  
o [Optional]  Reference:  Enter any reference notes pertaining to that 

payment. These notes will appear on the Receipts Report. 
o Click the “Apply” box on the line of the invoice you wish to pay 
o Click the “Save” button to save the record. 
 

 
 

NOTE:  The “Applied On” date is automatically filled in during month end 
closing. The date will indicate the ending date range for the billing in which 
the procedure was included. 

 
Unapplied Payments 

If a person makes a payment and there are no outstanding invoices or if they 
pay more than what is currently owed, it is considered an “unapplied 
payment” and the amount will be shown in red. 
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If there are unapplied amounts you will have to apply them once invoices 
become available. 
 
To apply an unapplied payment go to A/R Transactions > Payments and select 
the client.  On the payment history screen select the unapplied payment entry 
and click “Edit”. 
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Click the “Apply” box on the invoice you which to apply.  The amount to be 
applied will now show $0 and is no longer in red. 
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NOTE:  On the payment search history screen the Applied On date shows 
which billing has picked up the payment. If the Applied On date is blank, 
the payment has not yet been included in a closed billing. 
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Note:  Once a payment has been picked up and included in billing and that billing 
has been finalized, you cannot make any changes to the dollar amount that has 
been posted and you cannot delete the payment entry. 
 
 
2. Adding Adjustments (Direct Charges/Credits) 

 

o Select “A/R Transactions” from the menu 
o Select the “Adjustments” menu item 
o Select the client’s name  
o Click “Add” to enter a new Adjustment (Direct Credit/Charge) for that 

client.  Date Applied:  Enter the date of the adjustment. 
o Applied To:  Select the billing system where the adjustment will be 

applied (Standard, Monthly, Month End, etc.) 
o Enter the amount of the adjustment (the system will automatically fill in 

the G/L Account Number, the G/L Amount and the Total Distribution). 
 

 
 
Note:  A positive number entered in the Amount field such as $642.00 See (A) 
will add a charge to the client’s balance and a negative number such as -$642.00 
or ($642.00) will deduct the amount from the client’s balance. See (B) 

 
 

A 
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o Add the optional “Adjustment Comment” which will show the 
explanation for the adjustment on the client’s invoice if you check the 
box “Show Comment on Invoice?”  This Invoice Comment will also 
appear on the Adjustments Report. 

 

 
 
NOTE:  On the adjustments search history screen the Applied On date 
shows which billing has picked up the adjustment. If the Applied On date 
is blank, the adjustment has not yet been included in a billing. 

B
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NOTE:  On the Adjustments Entry/Edit screen the “Applied On” field is 
automatically filled in when you finalize the billing. See (A)  

 

 
 

o After you have entered the Date Applied, the Amount and then 
selected an item from the Applied To drop down list, you will 
next click on the Invoice Allocation tab. 

 

 
 
On the Invoice Allocation page you can either apply the adjustment to an 
existing invoice or you can click “New Invoice” to keep the adjustment as a 
separate entry.  Until you actually apply the Adjustment to an invoice you 
will see the (Amount To Be Applied) $642.00 in Red. 

A 
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To apply the Adjustment to an existing Invoice, click the Apply Box on the 
left side of the screen. 

 
 
To apply the Adjustment to a New Invoice, click the button “New Invoice” 
at the bottom – left side of the screen. 
 

 
Click “Save” to save the record. 
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3. Editing Adjustments (Direct Charges/Credits) 
o To edit an existing entry that has not been finalized, select “A/R 

Transactions” from the menu 
o Select the “Adjustments” menu item 
o Select the client’s name and click  “Select” 
o Click on the entry that you want to edit and click “Edit” 
o Make changes as needed  and click “Save” 

 
Note:  Once an adjustment has been picked up and included in billing and that 
billing has been finalized, you cannot make any changes to the adjustment entry 
and you cannot delete the adjustment entry. 
 
4.  Entering a “Zero Dollar” Adjustment 
If a client has a credit invoice and an unpaid invoice you can enter a “Zero Dollar” 
adjustment to offset the invoices. 
 

 
 
Select A/R Transactions > Adjustments 
Select the Client 
 

 
 
Click “Add” 
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Enter the Date Applied 
Select the “Applied To” 
Enter $0.00 in the amount field 
 
Click on the “Invoice Allocation” tab. 
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In this example, a credit invoice for ($85.87) will be applied to the outstanding 
invoice of $185.75.  To process the Zero Dollar Adjustment, enter a positive 
$85.87 in the Amount To Apply column for Invoice #100000827 and then click 
the Apply box on the line for Invoice #1000001100.  A negative (credit) amount of 
($85.87) will automatically be entered in the Amount To Apply column for Invoice 
#1000001100.  You have now applied the credit invoice to the outstanding 
invoice and the net effect is $0.  Click “Save”. 
 

 
 
 
Auto Allocation 
 

 
 
At any time during the month you can run the “Proposed Auto-Allocation Report 
to see if there are any clients that have any unapplied payments or credit 
invoices that can be applied. 
 

1. Click on “A/R Transactions” 
2. Click on “Auto-Allocation, “Standard” and then “Proposed Auto-Allocation 

Report. 
3.   Click “Submit to view the report. 
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The report will display the clients that have either an unapplied payment that 
now can be applied to an unpaid invoice or a credit adjustment that can now be 
applied to an unpaid invoice. 
 
The Auto-Allocation feature will allocate funds to the oldest invoices first.   
 
In the example above, there is an unapplied payment in the amount of $500.00 
for the client Annie McGillicutty.  The Auto-Allocation will take the $500.00 and 
pay off three invoices completely  

 
 
and pay one invoice partially. 
 

 
 
In the example above there is also a credit invoice in the amount of ($256.75) for 
the client Sara Pterra. The Auto-Allocation will take the ($256.75) and pay of one 
invoice completely and then partially pay one invoice. 
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If you do not want the program to Auto-Allocate a particular entry, go back to the 
specific Payment screen or the specific Adjustment Entry/Edit screen and click 
the box “Do Not Auto-Allocate” 
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Once you have reviewed the report and you agree with the Proposed Auto-
Allocations, click “Finalize Auto-Allocations” 
 

 
 
Click the box to Print the Journal after the Allocations have been created and 
then click the button “Finalize Allocations”. 
 

 
Click “Yes” if you wish to continue. 
 

 
 
Confirmation that the Auto-Allocation is complete will appear, click “Ok” and then 
print the Auto-Allocation Journal.  As the message indicates, you will need to re-
generate if you are processing your billing at this time. 
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A/R Transactions Reports 
 

 
 

 
1. Payments Report 

 

 
 

This will print a report of the payments that have been entered into the system 
based on the criteria selected.  You can specify any date range, a specific client 
or all clients and include only those payments that have not been billed yet or 
show all receipts for that date range including those that have already been 
billed. 
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NOTE:  Syndicate Billing Payments and Stud Fee Billing Payments pertain only 
to those clients that have purchased the “Stallion Module”. 
 
 
Payments Report Example #1 
 

 
 

 
 
This example shows payments for all clients from 5/27/2010 thru 09/30/2010 that 
have not been closed. 
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Payments Report Example #2 
 

 
 

 
 
This example shows all payments for the client February Rain Farm from 
05/17/2007 thru 09/30/2010 whether they have been closed or not. 
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NOTE:  The comments shown on this report are those comments that were 
entered in the “Payment Comment” field on the Payment Entry/Edit form. 
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2.  Adjustments Report 
 

 
This will print a report of the Adjustments that have been entered into the system 
based on the criteria selected.  You can specify any date range, a specific client 
or all clients and include only those Adjustments that have not been billed yet or 
show all Adjustments for that date range including those that have already been 
billed. 
 
Adjustments Report Example #1 
 

 
This example shows payments for all clients from 6/01/2010 thru 09/30/2010 that 
have not been closed. 
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Adjustments Report Example #2 
 

 
 
 

 
This example shows all Adjustments for the client Drew Elliott from 06/01/2007 
thru 09/30/2010 whether they have been closed or not. 
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NOTE:  Syndicate Billing Adjustments and Stud Fee Billing Adjustments pertain 
only to those clients that have purchased the “Stallion Module”. 
 

 
 
NOTE:  The comments shown on this report are those comments that were 
entered in the “Adjustment Comment” field on the Adjustment Entry/Edit form. 
 
 
 
3.  Aged A/R Report 
 

o You can select to print <All> clients for this report or you may select 
just one client from the drop down list. 
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The Aged A/R Report will show you what the total balance is for each client 
after the last closing.  This report shows any “real-time” interim Payments or 
Adjustments along with the (new) actual Adjusted Balance after the interim 
Payments and/or Adjustments have been entered. 
 
When you finalize the billing, the Total Balance, Current, Over 30, Over 60, 
Over 90, Accumulated Service Charges are all updated and the Interim 
Payments and Interim Adjustments are set back to $0.00. 

 
4. Detailed A/R Report 
 

 
 
This menu option prints a Detailed Accounts Receivable Report for any given 
date range.  You can select to print the report for <All> clients or you can select a 
client name from the drop down list and print the report for just one client. 
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The Detailed Accounts Receivable Report shows the Invoice Number, the 
Invoice Date, Invoice Amount, the Payment or Adjustment Date, Check Number, 
Reference, Comments, the Actual Payment or Adjustment Amount, the Debit and 
Credit Account number and the Balance.   
 
The report will group the account information into 30, 60, 90 days aging  and 
current aging. 
 
The Payment/Adjustment Amount column will indicate if the amount is an Invoice 
(I), Service Charge (S), Receipt (R) or an Adjustment (A). 
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5.  Unapplied Payments Report 
 

 
 
To print this report you can select any date range and <All> clients or you can 
select just one client from the drop down list. 
 
 

 
 
This report will show all unapplied payments whether or not they can be applied 
to an outstanding invoice at this time.   
 
NOTE:  Syndicate Billing Payments pertain only to those clients that have 
purchased the “Stallion Module”. 
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6.  Credit Invoices Report 
 

 
 

To print this report you can select <All> clients or you can select just one client 
from the drop down list. 
 

 
 
This report will show you all outstanding credit invoices whether or not they can 
be applied to an outstanding invoice at this time. 
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7.  Unapplied Payments with Unpaid Invoices Report 
 

 
 
NOTE:  The Syndicate button pertains only to those clients that have purchased 
the “Stallion Module”. 
 
This report shows only those clients that have an unapplied payment or a credit 
invoice that can be applied to an outstanding invoice.  A client will also show up 
on this report if they have only credits but no invoices that are currently due. 
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If you don’t want to manually apply the unapplied payments or manually enter $0 
adjustments, you can go to the menu option A/R Transactions > Auto Allocation 
and follow the steps to have unapplied payments and/or credit invoices 
automatically allocated to unpaid invoices. 
 
 
8. Billed Charges Report 
 

 
 
This report will show you either billed procedure charges or boarding charges or 
a combination of both based on the criteria selected.   
 
First select which Billing Period (Starting date and Ending date) and then select 
any additional criteria you wish to include on the report. 
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This example shows Boarding charges for the horse Blackeyed Susan for the 
billing dates 10/01/04 – 12/31/07. 
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This next example shows Boarding and Procedure charges for the horse 
Blackeyed Susan for the billing dates 10/01/04 – 12/31/04. 
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MONTH END BILLING 

 
Standard Billing 
 

 
 
 

Processing the Billing 
 
The steps for processing the billing are as follows: 

1. Generate Billing 
2. View the Preliminary Reports 

i. Make any necessary changes 
ii. If you make changes, Generate again 
iii. After generating, review the Preliminary Reports  

3. Finalize the Billing only when you are satisfied that all 
information is correct 

4. Print the Invoices 
5. View and/or print any or all of the Historical Reports  
 

To start the billing process, the system needs to calculate board and 
procedure charges for each horse and allocate all charges to the 
appropriate owner based upon arrival and departure dates, percentages of 
ownership and dates the charges were incurred.  All of this is done in a 
single process. 
 
o Select “Billing” > “Standard” from the menu 
o Select "Generate Billing” 
o Select the billing range by entering a “From Date” and a “To Date” for 

the billing you are going to process.  
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o To generate the billing for all clients and all horses for the selected 
date range, leave Client as <All> and leave Horse as <All>. 

o Click “Generate” to begin the processing. 
o To generate the billing for just one client and all of the horses owned 

by that client,  select the specific client’s name from the drop down list, 
leave Horse as <All> and click “Generate” 

o To generate the billing for just one horse and all owners (if applicable), 
select the specific Horse name from the drop down list, leave Client as 
<All> and click “Generate” 

o To generate the billing for just one horse for just one client, select the 
Client name from the drop down list, select the Horse name from the 
drop down list and click “Generate” 

o After the Generation process is complete, select “Billing” > “Standard” 
> “Preliminary Reports” > “Pre Billing”.  Review the Pre-Billing Report 
carefully. 
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Note:  The Generate Billing process may be done as many times as 
necessary. If you generate, review the pre-billing and then find something 
that needs to be corrected and/or changed (adding procedures, payments, 
receipts; changing ownership, board rates, board types, etc), simply make 
the necessary changes and generate again.  This generation process 
simply allows the system to sort through all of the records to see what 
should be included in the billing date range you have selected as well as 
to pick up any changes you have just made. 
 
Once you are satisfied that the Pre-Billing is correct, continue the billing 
process by printing or viewing the remaining Preliminary Reports. These 
reports will be used to verify the billing charges and may be run as many 
times as necessary. In order for these reports to print accurate up-to-date 
information, remember that if you have made any changes, you must first  
“Generate” before running the Preliminary Reports again. 
 
 
TIP:  The generate process will pick up all procedures that fall within the 
selected date range as well as any procedures that were performed prior 
to the selected date range that have not yet been billed.  
 
For example, a vet ticket might get turned in after you have already closed 
a billing period.  You enter the charge on the date it happened last month 
and when you generate for this month, the system will see that the 
procedure has not yet been billed and it will pick up the procedure and 
include it in the current billing. The generate process will never pick up 
procedures that have been performed beyond the selected date range.  
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TIP:  The generate process will pick up and include all Adjustments (Direct 
Credit/Charge) entries that fall within the selected date range as well as 
those that were entered prior to the selected date range that have not yet 
been billed.  The generate process will not pick up Adjustments that have 
been performed beyond the selected date range. 
 
TIP:  The generate process will pick up all cash receipts, regardless 
of the payment date that have been entered and will include them in 
the current billing. 
 
 

Unapplied Payments or Credit Invoices with Unpaid Invoices 
 

 
 
When you generate your billing this message will appear if you have any 
clients with Unapplied Payments or Credit Invoices that can be applied to 
outstanding invoices. 
 
Click “Yes” to see the report 
Click “No” to not see the report at this time and continue with the generate 
process. 
 
If you click “Yes”, the report will be displayed on the screen. 
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You can manually process these items or you can go back to the menu 
option A/R Transactions > Auto Allocation > Standard, view the Proposed 
Auto Allocation Report and then Finalize the Auto Allocation.  (See 
Section (“Maintaining Client Balances”) 
 
IMPORTANT NOTE:  If you do not make the offsetting entries your client 
balances will not age properly.   
 
 
 
 
 
 
 
 
 



 

 
  Page 156 of 324

 
 

 
Preliminary Reports 
 

 
 
 
Pre-Billing Report 
 

 
o The Pre-Billing Report is NOT the invoice.  It is a report that lists all of 

the board and procedure charges based on the Billing Generate dates 
that were selected.  The report is alphabetical by client and then for 
each client the horses are listed alphabetically. This report allows you 
to quickly review and verify the charges for each client / horse before 
continuing to the next step in the billing process. 

o You can select <All> clients, <All> horses, you can select one client 
from the drop down list and <All> horses, you can select one horse 
from the drop down list and <All> clients or you can select one horse 
from the drop down list and one client from the drop down list. 
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o In this sample pre-billing one client was selected (Sara Pterra) and 

<All> horses. 
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o The Pre-Billing Report will show the Boarding Total, the Procedure 

Total, the total Payments, Adjustments and Service Charges.  There 
will also be a G/L Account summary at the very end showing the totals 
for each G/L Account. 

o If you have selected to Suppress a client’s billing, you can still view 
and/or print the Suppressed Billing charges. 
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Adjustments Report 
 
o This report shows a complete listing of any Adjustments (Direct 

Charges or Credits) you have entered that will be included in this billing 
cycle. 
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Payments Report 
  

o This report shows a complete listing of all of the cash receipts that will 
be included in this billing cycle.   
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Boarding Charges Report 
 

o This report lists only boarding charges for each horse.  It will show the 
horse’s Boarding type, boarding dates, rate, total amount charged and 
a grand total of horse days for the billing cycle.   

o It is helpful to Group by Boarding Type so that you can easily 
review all the horses in each Boarding Type group.  When you group 
by Boarding Type, the list will be shown alphabetically by each 
Boarding Type. 
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Service Charges Report 
 

 
 
o This report shows the service charges that will be applied for the 

selected billing date range.  This report lists each client that will be 
getting a Service Charge (late fee) and the amount of the Service 
Charge. 

 

 
 
 

o If you click the box to Include Details, the report will show the Invoice 
Numbers and the late fees that will be applied to each invoice for this 
billing cycle. 
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Services Tax Report 
 

 
 

o This report will show the client’s name and the total Services Tax 
amount for each client for this billing cycle. 

 . 
 

 
 
Note:  This feature is used by international clients. It allows the entry of a service 
tax such as GST, HST, VAT, etc. to be charged on selected boarding types 
and/or procedures 
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Preliminary A/R Report 
 

o This report shows what your client balances will look like after this 
billing cycle is closed. 

 
 
Detailed A/R Report 
 

o This report shows the Invoice Number, the Invoice Date, Invoice 
Amount, the Payment or Adjustment Date, Check Number, Reference, 
Comments, the Actual Payment or Adjustment Amount, the Debit and 
Credit Account number and the Balance.  The Payment/Adjustment 
Amount column will indicate if the amount is an Invoice (I), Service 
Charge (S), Receipt (R), Unapplied Payment (U) or Adjustment (A). 

 
o The report will group the account information into 30, 60, 90 days 

aging and current aging. 
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Closing Summary 

 
o  This is a one-page report summarizing your clients’ Beginning 

Balances, Cash Receipts, Direct Charges/Credits, Procedure Charges, 
etc. 

 

 
 
 
Board and Procedure Revenue Report 
 

o This report will display all of the board and procedure charges for the 
current billing.  The charges will be sorted by G/L account numbers 
first and then by farm. The G/L Account Summary is on the last page 
of this report and will separate the board charges from the procedure 
charges if G/L Numbers have been assigned. 
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Invoices 
 
These are NOT your final invoices - these are your Edit invoices and should be 
reviewed for accuracy before you actually finalize the billing. At this point you can 
still make any changes and/or corrections, generate again and review the Edit 
invoices. 
 
Remember:  You can choose to have the invoice summarized or you can show 
all of the detail. 
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This Sample invoice shows all of the Detail. 
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This Sample invoice is for the same client but has been Summarized. 
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Billing – Finalize Billing 
 

 
 
To make the billing process final, the system must update tables to reflect the 
current billing balances, record aging balances, flag procedures as having been 
invoiced, etc.  This process is accomplished when you select “Finalize Billing”. 
 
Finalize Billing is the final step in the billing process.  Do NOT select this option 
unless you have reviewed all of the Preliminary Reports are satisfied that your 
billing is correct. 
 
To Finalize the billing, go to Billing > Standard and click on “Finalize Billing”.  If 
you have generated for <All> Clients and <All> Horses, the finalize screen will 
look like this: 
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If you have generated for only one client, the Finalize Billing screen will look like 
this: 

 
 
 
 
If you have generated for only one horse, the Finalize Billing screen will look like 
this: 

 
 
 
Click “Finalize” to begin the process. 
 

 
 
Click “Yes” to continue the finalization process. 
Click “No” if you do not want to Finalize at this time. 
When the Finalize has been completed, you will get this message. 
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After the Finalize has completed you will print your invoices. 
 
Go to Billing > Standard> Print invoices 
 

 
 
NOTE: A/R Aging Files are not updated until the Finalize process is 
performed.  
 
NOTE:  If you have selected to Suppress the Billing on any of your clients, 
the billing process will NOT produce an invoice for them. See (A) & (B) 
 

 
 

 
 
 
 
 

A

B
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While there is no actual invoice, you can print several reports to see what 
the suppressed charges are for that billing period.   
 
To see the Suppressed Charges you can print a Pre-Billing Report (A) just 
for Suppressed Billing, you can print Boarding Charges (B) just for 
Suppressed Billing, and the total amount of suppressed charges for the 
current billing will appear on your Closing Summary Report (C). 
 

 
 
 

 
 
 
 

A 

B 
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NOTE:  “Finalize Billing” option should not be selected until you are 
satisfied that all information in the billing is correct.   

 
Once the Finalize Process has completed you can print your invoices and you 
can print any of the Historical Journals that were saved during the Finalize 
process.  
 
To view and/or print the final invoices go to Billing > Standard > Print Invoices.   
 

 
 
 
 
 
 
 
 
 
 
 

C
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Select the Billing Period Ending Date and select <All> clients or select just one 
client from the drop down list. 
 

 
 
 
NOTE:  You can also print your final invoices by going to Billing > Standard > 
Historical Reports > Invoices and select the Billing Period Ending Date and <All> 
clients or select just one client from the drop down list. 
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Once the Finalize process has been completed, the “EDIT” watermark is 
removed from the invoice. 
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Printing Invoices and Historical Journals 
 

 
 
To print Invoices or any of the Historical Journals go to Billing > Standard > 
Historical Reports 
 

 To print Invoices, select “Invoices” and then select the Billing Period 
Ending date and <All> clients.  If you only want to print one client’s 
invoice, select the Billing Period Ending date and then select the one client 
from the drop down list. 
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 Or you can go directly to the Save folder and view/print any of the 

Historical Journals from that location. 
 

 
 
 

 
 
 Each folder in the directory is named according to the ending date range 

for each billing that has been finalized.  Find the ending date range for the 
billing you want to view and click on the folder.  
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 All Historical Journals including the Invoices are saved as PDF files.   
 
 When you find the file you want to open, double click on the file.  The file 

will open up and you will be able to view and/or print.   
 

 
Note:  The invoices will be at the top of the list and the number before the .PDF 
file extension represents the client’s actual client Number. 
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MARE INFORMATION 

Recording the Breeding Season 
 

 
 

1.  Creating a Mare’s Breeding “Season” Record 
 

o Select “Mare Info” from the menu. 
o Select "Mares" menu item. 
 

Note: You can also get to this screen by clicking the “Mare Info.” button in the 
“Horse Entry/Edit” form. 
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o Select a mare name from the list on the screen and press “Edit” 

or double-click on the mare name. 
 

 
 
If the horse is not yet in the mare list and you want to add her as a Mare, click the 
Add button to see your complete horse list and then click on the name of the 
horse you want to add as a mare and click “Select”. 
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o Enter New Season Year:  Enter the “Season Year” and press 
“OK”.  
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If the mare is already in the Mare list, select her name and click “Edit”.  
 

 
 

o Season Year:  Click the “New” button, enter the “Season Year” and 
click “OK” 
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o Starting Status:  Select the mare’s Starting Status from the drop 
down list.  The Starting Status reflects her reproductive status on 
January 1 of the New Season Year that you just added. (Maiden, In 
Foal, etc.)  

o Booked To:  Enter the name of the stallion that the mare is 
scheduled to be bred to for that breeding season (“Booked To” 
field).  You can either type in the name of the stallion, or if you have 

entered the stallion in your master horse list, click on the “ ” 
button and select the stallion from your master list of horses. 

o [Optional] Share Owner:  Enter the name of the person/farm that 
owns the share you are breeding the mare on. 

o [Optional]  Share #:  Enter the share number you will be using. 
o [Optional] Confirmed By / On:  Enter the name of the person that 

confirmed this breeding on this share and select the date it was 
confirmed.  Remember you can manually enter the date or you can 
click the drop down arrow and select a date from the calendar. 

o Standing Farm:  Enter the name of the farm where the stallion 
stands.  You can type in the name of the farm or you can click on 

the “ ” button and select the farm name from your master list of 
farms. 

o If you selected the farm name from the master farm list, the system 
will automatically fill in the farm’s phone number, contact name and 
breeding requirements (if you had originally entered this information 
in the farm master file list). 

o If you did not select the farm name from the master farm list, you 
can manually enter the Farm Name, Contact name, the farm’s 
phone number and the farm’s Breeding Requirements. 

o Final Status:  At the conclusion of the breeding season, select the 
mare’s status from the drop down selection (In Foal, Barren, 
Slipped, Not Bred, etc.) 

o Last Exam:  As the mare is checked for pregnancy during the 
season, you can enter her status in the “Last Exam” field (Pg, Pd, 
Pd+, Barren, Slipped, etc.) 

o Last Date Bred:  The system will automatically fill in the “Last Date 
Bred” field in the lower left hand side of the Mare Info. Entry/Edit 
screen. 

o Mare Info Comments:  Comments entered in this field will show up 
only on the “Broodmare Listing” report. 
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Note:  Previous Season information and Foaling Info are read-only fields.  The 
Previous Season information will be populated with the breeding information from 
the previous year if it has been entered and the Foaling Info will be populated 
with the foaling information from the previous season if it has been entered. 
 
 
 
Mare Info Sheet and Breeding Shed Form 
 

 
 
These forms are time savers as they are pre-populated with the mare information 
found in the Mare Entry/Edit screens.  You can print them out and send them 
with the mare when she goes to the breeding shed. 
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2.  Automatically Adding New Broodmare Season Records 
 

 
 

o Select “Mare Info”  
o Select Generate Broodmare Season 
o Enter the Season Year and select Generate 

 

 
 

 
 

o The “Generate Broodmare Season” is used to generate a new 
season record for all mares at one time.  In order for the system 
to generate a new season record, the mare must have a 
previous record to generate from and the mare must have a     
current arrival date.  You can generate new season records at 
any time during the year and as many times as needed or you 
can add seasons one by one manually.   
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Note:  The system will automatically print a list of mares that it has created 
a new season record for each time you generate.   
 

o If there are no mares that need a new season, you will get a 
message to that effect when you generate.  Mares that already 
have a season will not be duplicated. 

 

 
 

   
3. Booking the Mare for Breeding 

 
o Select “Mare Info” from the menu. 
o Select "Mares” 
o Select a horse name from the Mare Entry/Edit list and click 

“Edit” (You can also get to this screen by clicking the “Mare 
Info.” tab on the “Horse Entry/Edit” form)  

o Select the season that you would like to work with 
o Click on the “Breeding Dates” tab to open the “Breeding Dates 

Entry/Edit” Screen 
 

 
 

o Click “New” 
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o Enter the date the breeding is scheduled  
o Enter what time the mare is booked to be bred 
o [Optional] Enter the Session number 
o The system will default the status to “Scheduled” and place the 

name of the stallion in the “Stallion” column.   If the stallion 
name does not appear in the stallion column, check to be sure 
you actually entered the stallion’s name in the “Booked To” field 
on the mare info. tab. 

o [Optional] Select who will van the mare to the breeding shed 
(Vanned By) 

o [Optional] Enter what time the mare will be picked up to go to 
the breeding shed (Pickup Time) 

o [Optional] Enter any scheduling comments (needs a double 
stall, do not hobble, etc.).   

o Click “Save” 
 

4.  Recording the Breeding Dates 
 
 When you have confirmation that the mare has been bred: 

o Select “Mare Info” from the menu. 
o Select "Mares” 
o Select the horse name from the Mare Entry/Edit list and click 

“Edit” (You can also get to this screen by clicking the “Mare 
Info.” tab on the “Horse Entry/Edit” form)  

o Select the season that you would like to work with 
o Click on the “Breeding Dates” tab to open the “Breeding Dates 

Entry/Edit” Screen 
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o Select  “Bred” in the status area 
 

 
 

 
 

o [Optional] Enter any comments related to the breeding 
(Excellent Cover, etc.) 

o [Optional]  Print breeding comments on invoice:  Click in the box 
if you want the breeding comments to appear on the client’s 
invoice.  Leave the box blank if you do not want the comments 
to appear on the client’s invoice.   Note:  in order for this option 
to work, you must have already set up a single procedure as 
your “Breeding Procedure”.  See Master Files “Procedure 
Master Entry/Edit” section. 
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o These comments will appear as part of the horse’s health record 
whether or not the “Print breeding comments on invoice” box is 
checked if you have set up one procedure as your “Breeding 
Procedure”. 

o Click “Save” 
 

 
 

o Last day the mare was bred:  The system will automatically fill 
in the “Last Date Bred” field in the lower left hand side of the 
Mare Entry/Edit screen. 

 
Note: Comments entered in the “Mare Info Comments” area will print only on 
the “Broodmare Listing” report. 

 
 

5.  Recording the Foaling Information 
 

Important Note: Foaling information must be entered in the mare’s record 
based on the breeding season not the foaling year.  For 
example: If a foal is born on 3/17/11, that foaling information 
must be entered through the 2010 season. 

 
o Select “Mare Info” from the menu. 
o Select "Mares” 
o Select the horse name from the Mare Entry/Edit list and click 

“Edit” (You can also get to this screen by clicking the “Mare 
Info.” tab on the “Horse Entry/Edit” form)  

o Select the season that you would like to work with 
o Click on the “Foaling Info” tab to open the “Foaling Entry/Edit” 

screen.  
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Enter the foaling information: 
o The foaling date 
o The time the water broke 
o The time of foaling 
o The time that the foal stood 
o The time that the foal nursed 
o The time that the placenta was shed 
o The name of the farm where the mare foaled 
o The foal’s color and the foal’s sex 
o Enter any comments related to the foal or foaling 
o After entering all of the foaling information, click the “Add Foal 

as New Horse” button (A) 
 

 
 
 
 
 
 
 
 
 
 
 
 

A 
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o The foal’s name will be pre-populated based on the settings you 
selected in Setup > Preferences >  Mare/Foal Settings 

 

 
 

o Edit the foal name if necessary 
o Select the Board Type 
o The Foaling Date will be pre-populated based on the foaling 

date you entered on the foaling info. page. 
o Click “OK” and the system will automatically create a new horse 

record for the foal using the information you have supplied in the 
Foaling Entry/Edit screen.  The system will assign ownership of 
the foal to be the same as the dam’s ownership and it will 
automatically enter an arrival date in the Boarding screen. 

o Click “Save” 
 
 

 
Teasing Information 
 

 
 
Teasing Worksheet 

 
This produces a worksheet where teasing results and comments can be 
noted and then later entered into HFM. 

 
 Select “Mare Info” 
 Select “Teasing Worksheet” 
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 Select the date for current results. 
 Select a specific farm from the drop down list or leave Farm as <All> to 

print worksheets for all farms. 
 Accept the default to show “Only Currently Boarding” mares or remove the 

“check” to show all mares on the report. 
 

 
 
This report shows the mare name, the date the mare is due to foal, the actual 
foaling date, the last day she was bred, the results from the last 7 days of teasing 
(based on the result date selected) and an area to note the current day’s teasing 
results and comments. 

 The “Due Date” is calculated based on what you entered in Setup > 
Preferences > Mare/Foal Settings (Days Between Last Day Bred and 
Foaling Date).  The value for “Due Date” can be any number that you 
want to enter.   
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Teasing Results Entry 
 
To enter teasing results for mares 
 

o Select “Mare Info” from the menu. 
o Select "Teasing Results Entry" menu item. 

 

 
 

o First enter the Teasing Date and then click “Display”.  The list 
will show all mares that have a breeding season set up.  If you 
want the list to display mares that are Not Currently Boarding, 
uncheck the “Only Currently Boarding” box. 

 
o Enter the teasing results for that day and any comments and 

click “Save”.  We recommend that you enter only three (3) 
characters in the Teasing Results field since the teasing reports 
will only display three (3) characters.  Comments are stored in 
this record only and will not appear on any reports 

 
o If you want to enter several teasing results for several days just 

enter a new teasing date, click “Display” and enter the results as 
before.  When finished, click “Save”. 
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Teasing Results Entry (From the Mare Information Page) 
 

o Select “Mare Info” from the menu. 
o Select "Mares” 
o Select the horse name from the Mare Entry/Edit list and click 

“Edit” (You can also get to this screen by clicking the “Mare 
Info.” tab on the “Horse Entry/Edit” form)  

o Select the season that you would like to work with 
o Click on the “Teasing Results” tab to open the “Teasing Results 

Entry/Edit” Screen 
 

 
 

o Enter the Teasing Results for this mare.  We recommend that 
you enter only three (3) characters in the Teasing Results field 
since the teasing reports will only display three (3) characters. 

o Enter any Teasing Comments.  These comments are stored in 
this record only and will not appear on any reports. 

o Click “Save”  
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Teasing Results Report 
 

 Select “Mare Info” 
 Select “Teasing Results Report” 
 

 
 
 Select the season from the drop down list. 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see all farms. 
 Select an owner from the drop down list or leave “Owner” as <All> to see 

teasing results for all horses 
 Select a specific horse type from the drop down list or leave “Horse Type” 

as <All> to see teasing results for all horse types. 
 Select a specific horse from the drop down list or leave “Horse” as <All> to 

see teasing results for all horses or select a Band Tag from the drop down 
list instead of the horse name. 

 Leave the box checked to Show Only Currently Boarding Mares or 
uncheck the box to see all mares for the season selected. 

 Select to sort the report by Farm or Horse.  If sorted by Farm, the report 
will list the farms in alphabetical order and then the horses within each 
farm alphabetically.  If sorted by Horse, the report will list alphabetically by 
horse name regardless of the farm. 

 Select the month range. 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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This report will show the mare name, the name of the farm, the mare’s sire, 
dam, color, YOB, stallion bred to previous season and LDB previous season, 
current foaling date, color and sex of the foal, stallion booked to in current 
season, beginning status and final status for current season. 
 
This report will show any Teasing results that have been entered for each 
horse (Mare Info > Mares >Teasing Info.) or (Mare Info > Teasing Results 
Entry).  Additionally, this report will show entries for LO, RO, Cervix & Other 
(Master File > Procedure Master > “Procedure Types: Results on Teasing 
Chart & Update Mare Exam Status) 
See Example (A)
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Example (A) 
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Mare Info Reports 
 

 
 
 

1.  Foaling  Report 
 Select “Mare Info” 
 Select “Reports” 
 Select “Foaling” 

 

 
 
 Select the date range you want to see 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see all foals at all farms. 
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 [Optional] Group by Farm 
 [Optional] Show only currently boarding mares 
 [Optional] Format the report to be exported  
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
 
The Foaling Report pulls information directly from the “Foaling Info” page on 
the “Mare Entry/Edit” screen.   
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 The Foaling Report shows the sequence number of the mare, the 

mare’s name, the name of the stallion that the mare was bred to in the 
previous season, the color of the foal, the sex of the foal, the date the 
mare foaled, what time the mare foaled and any comments that were 
entered in the “Foaling Info” screen. 

 
2.  Breeding  Report 

 Select “Mare Info” 
 Select “Reports” 
 Select “Breeding” 

 

 
 

 Select the Season 
 Select one particular farm or leave “Farm” as <All> to see all mares at 

all farms 
 If you want the report to be Grouped by farm, click in the box next to 

“Group By Farm”  
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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This report lists the sequence number of the mare, how many times the mare 
was bred, the mare’s name, the last day the mare was bred, whether the last 
day bred was a double, the name of the stallion she was last bred to, how 
many days since the mare was last bred and the status of the mare after her 
last exam. 
 

 As mares are re-bred, their names will automatically be re-arranged in 
chronological order. 

 The Status column pulls information from the “Last Exam” field on the 
Mare Entry/Edit screen. 

 

 
 



 

 
  Page 211 of 324

3.  Outside Bookings 
 Select “Mare Info” 
 Select “Reports” 
 Select “Outside Bookings” 
 

 
 
 Select the date range you want to see 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see the outside bookings for all mares at all farms. 
 Click the box “Show Cancelled Bookings” if you want the report to show 

the bookings that have been cancelled.  If this box is blank, no cancelled 
bookings will print on the report. 

 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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 The Outside Bookings report will show you what day of the week the 

mare is scheduled (Mon, Tue, etc.), the actual date the mare is 
scheduled to be bred (m/dd/yyyy), the time the mare is booked, the 
mare’s name, the name of the stallion the mare is booked to, the name 
and phone number of the farm where the stallion stands, the breeding 
requirements at the stallion farm, who will van the mare to the breeding 
shed and what time they will pick her up. 

 Additionally, the Outside Bookings report will show any booking 
comments that have been entered on the “Breeding Dates Entry/Edit” 
screen and whether or not the mare was Bred or the breeding was 
**Cancelled**.   
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4.  Farm Mares Bred Summary 
 Select “Mare Info” 
 Select “Reports” 
 Select “Farm Mares Bred Summary” 
 

 
 
 Select the Breeding Season. 
 Select one particular stallion from the drop down list or leave “Stallion” as 

<All> to see all stallions. 
 Select one particular Farm from the drop down list or leave “Farm” as 

<All> to see all farms 
 Select whether to sort the report by how many “Days Since Last Bred” or 

alphabetically by the “Mare Name”. 
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 

 



 

 
  Page 214 of 324

 
 

 This report shows the mare’s name, what her status was at the 
beginning of the Breeding Season, her foaling date, the name of the 
Stallion she was bred to, all of her breeding dates for the selected 
Breeding Season, how many days since she was last bred, her final 
status and her projected foaling date for the next year. 

 If the mare was bred to more than one stallion in a breeding season, 
each stallion’s name will be displayed. (A) 

 The “Begin Status” is pulled from the Mare Entry/Edit > Mare Info 
screen “Starting Status” field. 

 The “Final Status” is pulled from the Mare Entry/Edit > Mare Info 
screen “Final Status” field. 

 The “Projected Foaling Date” is calculated based on what you entered 
in Setup > Preferences > Mare/Foal Settings (Days Between Last Day 
Bred and Foaling Date).  The value for “Due Date” can be any number 
that you want to enter.   

  

 
 
 

 

A



 

 
  Page 215 of 324

5.  Broodmare Listing 
 Select “Mare Info” 
 Select “Reports” 
 Select “Broodmares” 
 

 
 
 Select the “Season” 
 Select one particular Farm from the drop down list or leave “Farm” as 

<All> to see all farms 
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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 This report will show information for the previous breeding season and the 

selected season for each broodmare. 
 The previous season will show the name of the stallion the mare was bred 

to, the farm where the stallion stands, the name of the person that 
confirmed the booking and the date the booking was confirmed, the last 
bred date, the foaling date, the foal color and the foal sex. 

 The current season will show the name of the stallion, the name of the 
farm where the stallion stands, the name of the contact person at the 
stallion farm, the Breeding Requirements for the stallion farm, the stallion 
farm’s phone number, the share number being used, the owner of the 
Share/Season, the name of the person that confirmed the booking and the 
date the booking was confirmed.   

 It also shows the beginning status for the selected season, the last day 
bred, the status of the mare after her Last Exam, the Final Status of the 
mare and any mare comments that were entered on the mare information 
screen. 
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6.  Mare List by Client 
 Select “Mare Info” 
 Select “Reports” 
 Select “Mare List By Client” 
 

 
 
 Select the “Season” 
 Select a particular farm from the drop down list or leave “Farm” as <All> to 

include all farms in the report. 
 Select a particular owner from the drop down list or leave “Owner” as 

<All> to include all owners in the report. 
 If the “Show Only Currently Boarding” is checked, only those horses that 

are currently boarding will be shown on the report. 
 If the “Sort by farm” is selected, the report will sort alphabetically by farm 

name.   
 If the Sort By “Owner” is selected, the report will sort alphabetically by the 

client’s last name. 
 Select to Preview the report or send it directly to the Printer 
 Click Submit 
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 This report will show the Owner’s Name, the Percent Owned, the Mare 
name, the horse Type, the name of the Farm where the mare is, the 
Season year (Previous Season and Selected Season), the name of the 
stallion that the mare was bred to, the last day the mare was bred, the 
Status After the Last Exam, the Final Status, the date the mare foaled 
and the foal color & sex. 

 The Status After Last Exam information is pulled from the “Status After 
Exam” field on the “Mare Entry/Edit” screen and the Final Status is also 
pulled from the “Mare Entry/Edit” screen from the “Final Status” field. 

 
 
Generate Broodmare Season 

o Select “Mare Info”  
o Select Generate Broodmare Season 
o Enter the Season Year and select Generate 
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o The “Generate Broodmare Season” is used to generate a new 
season record for all mares at the same time.  In order for the 
system to generate a new season record, the mare must have a 
previous record to generate from and the mare must have a     
current arrival date.  You can generate new season records at 
any time during the year and as many times as needed or you 
can add seasons one by one manually.   

 
 
Note:  The system will automatically print a list of mares that it has created 
a new season record for each time you generate.   
 

 
 

o If there are no mares that need a new season, you will get a 
message to that effect when you generate.  Mares that already 
have a season will not be duplicated. 
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REPORTS 

 

 
 
 
Base Reports 
 

 
 
 
1. Clients 
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This report prints a list of clients that have been entered into the system.  You 
can print just the clients’ names or you can include their address. You can 
also select to show only those clients whose horses are currently boarding. If 
the box “Include only boarding?” is blank, the report will list all clients even if 
they no longer are boarding horses with you. 
 
If the box “Show Inactive Records” is checked, those clients that have been 
marked as “Inactive” will also appear on the list. 

 
 
If the box “Sort Suppressed Clients First?” is checked, those clients that you 
have marked to “Suppress Billing” will appear at the top of the client list. 
 
If the box “Show Tax ID” is checked, the report will show the Tax ID that has 
been entered for the client.  If that box is not checked, the e-mail information 
for the client will show on the report. 
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 Horses 
 

 
 
 
This report prints a list of horses that have been entered into the system.  
You can create the report based on a combination of options: Sort by 
Farm Name or Horse Name and show only those horses Currently 
Boarding.  You can also print the list based on a particular horse type or 
Boarding Type and if the box is checked, you can Show Inactive Records 
(horses that have been marked as Inactive). 
 

 
 
Sort by:  Select “Farm Name” and the report will print each farm on a 
separate page.  Select “Horse Name” and the report will alphabetically 
print a list of all horses regardless of the farm. 
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3. Farms 
 

 
 
This report prints a list of farms that have been entered into the system.  The list 
includes Farm Name, Address, Manager, Contact, Vet, Owner and any phone 
numbers that you entered in the Farm Master File Entry/Edit form. 
 
If the box “Show Inactive Records” is checked, those farms that have been 
marked as “Inactive” will also appear on the list. 
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4. Boarding Types 
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This report prints an alphabetical listing of all of the Boarding Types that you 
have set up for your farm/company.  The Standard Board rate associated with 
each Boarding Type will be shown as well as the Default Horse Type that is 
associated with each Boarding Type. 
 
The report will indicate the G/L Number that has been entered for each Boarding 
Type and the Billing System.  Comments that were entered in the Board Type 
Entry/Edit form appear on this report. 
 
If the box “Show Inactive Records” is checked, those Boarding Types that have 
been marked as “Inactive” will also appear on the list. 
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5. Horse List By Client  
 

 
 
This report will show the list of horses that have been entered into the system. 

o You can select one Farm from the drop down list or leave Farm 
as <All> to see all horses at all farms. 

o You can select one Horse Type from the drop down list or leave 
Horse Type as <All> to see all horses at all farms. 

o You can sort the list by Owner 
o You can sort the list by Farm Name 
o You can sort the list by Horse Type 

If the box “Show Only Currently Boarding” is not checked, those Horses that are 
no longer boarding will also appear on the list. 
 
If the box “Show Inactive Records” is checked, those horses that have been 
marked as “Inactive” will also appear on the list. 
 
 



 

 
  Page 228 of 324

 
This list has been sorted by Owner 
 
 

 
This list has been sorted by Farm 
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This list has been sorted by Horse Type.   
 
Note:  If the Horse Type is blank you have not entered any Horse Type for that 
particular horse on the horse master screen. 
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Misc. Reports 
 

 
 
 

1. Arrival  
 

        
 
Enter a Starting Date and an Ending Date. 
This report prints a list of horses that have an arrival record within the date 
range that has been selected.   
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The report will sort by Farm and will list the Date of the arrival, the Horse Name, 
where the horse Arrived From, who Vanned the horse and the time of the arrival. 
 
The information on this report is pulled directly from the Boarding screen.  
(Master Files > Horses > Boarding). 
See Example (A) 
 
NOTE:  If no arrival time has been entered, the report will default to 12:00 am. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
  Page 232 of 324

 
Example (A) 
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2. Departure 
 

       
 
Enter a Starting Date and an Ending Date. 
This report prints a list of horses that have a departure record within the date 
range that has been selected.   
 

 
 
The report will sort by Farm and will list the Date of the departure, the Horse 
Name, where the horse Shipped To, who Vanned the horse and the Time of the 
departure. 

 
The information on this report is pulled directly from the Boarding screen.  
(Master Files > Horses > Boarding). 
See Example (B) 
 
NOTE:  If no arrival time has been entered, the report will default to 11:59 pm. 
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Example (B) 

 
 
 
 
 

3. Departure Form 
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For horses that are scheduled to leave the farm or have already left the farm, you 
can print a report that shows selected procedures that have been performed for 
any date or date range, for any group of horses that have departed the farm or 
for a single horse that has departed the farm or is scheduled to depart the farm. 
 
NOTE:  The procedures that appear on this report are based on the criteria you 
selected when you originally set up your Procedure Categories and your 
Procedure Masters  
 

 
 

 
 
 
If you are not satisfied with the procedures that are or are not appearing on this 
report, go back to the Procedure Category Entry/Edit and the Procedure Master  
and re-select either “No”, “Yes” or  “Last” in the “Departure Print” field.  Whatever 
has been selected in the Procedure Master Entry/Edit form will take precedence 
over what has been entered in the Procedure Category Entry/Edit form. 
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NOTE:  The “Results” column shows information that has been entered in the 
“Results” field on the procedures performed form. 
 

 
 

 
 
NOTE:  Comments entered in the “Departure Notice” field on the Horse Master 
form will appear on the Departure Form in the Remarks area.  (See Horse 
Entry/Edit) 
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4. Horse Notes 
 

 
 

This report is based on the information that has been entered through the “Notes” 
tab on the Horse Entry screen. 

 
(Master Files > Horse Entry/Edit > Notes)    See (A) Below 
 

 
 

A 
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To print the report: 

 Select a Starting Date and an Ending Date.  You might want to see 
information for one day, one week, one month, one year, or any other 
specific date range. 

 Once you have selected a date range, you have the option to create the 
report based on additional criteria. 

 Sort By:  Select have the report sorted by either the Client Name or by the 
Horse Name. 

 Boarding Only:  Click in the box if you want the report to list only those 
horses that are currently boarding.  Leave the box unchecked if you want 
to see all horses including those that are not currently boarding. 

 Category:  Select one specific Procedure Category from the drop down list 
or leave “Category” as <All> to include all Categories. 

 Procedure:  Select one specific Procedure from the drop down list or leave 
“Procedure” as <All> to include all Procedures. 

 Horse:  Select one specific Horse from the drop down list or leave “Horse” 
as <All> to include all horses. 

 Horse Type:  Select one specific Horse Type from the drop down list or 
leave “Horse Type” as <All> to include all Horse Types 

 Current Owner:  Select one specific Client from the drop down list or leave 
“Current Owner” as <All> to include all Owners. 

 Band/Tag:  Select one specific Band/Tag from the drop down list or leave 
“Band/Tag” as <All> to include all Band/Tags. 

 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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NOTE:  This report will automatically group by Horse Type. 
 
 
 
 
5. Health Record Report 

 

 
 
This report prints a comprehensive list of procedures that have been performed 
on a single horse or a group of horses.  You can select any given date range, 
include only those horses that are currently boarding, include only the 
procedures you have marked as “Health Type”, all procedures in all categories or 
only procedures in one category. 
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NOTE:  The “Results/Comments” column will show information that has been 
entered in the “Results” field and/or the “Procedure Comments” field on the 
procedures performed form. 
 
 

6. Mini-Pedigree 
     

 
 

Based on the information that has been entered in the Master Files > Horse 
Entry/Edit screen, this report prints a 2 Generation Pedigree. 
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 Horse Type:  Select one specific Horse Type from the drop down list or 
leave “Horse Type” blank to include all Horse Types. 

 Horse:  Select one specific Horse from the drop down list or leave “Horse 
Name” blank to include all Horses 

 Band/Tag:  Select one specific Band/Tag from the drop down list or leave 
“Band/Tag” blank to include all Band/Tags 

 Select to Preview the report or send it directly to the Printer 
 Click Submit. 

 

 
 

 
 
7.  Horse Movement 
 

 
 
Utilizing a combination of the Arrival/Departure dates and Movement/Transfer 
Procedures, this report will allow a user to track the Barn/Location movements of 
a horse. 
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You will first set up a procedure master to be the Movement/Transfer procedure. 
When you enter a Movement procedure for a horse, the current Farm, Location, 
Barn, Stall and Field will be displayed for that horse. 
 

 
 
Update the Movement Details fields to show the new information and click 
“Save”. 
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New location information has been entered for this mare. 
 
 
The Horse information page has been updated with the new location information. 
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The report will show Arrival and Departure dates and Movement information. 
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Procedure Reports 
 

 
 
 
1. Procedures Performed Report 
 

 
 
This prints a report of the procedures that have been performed based on the 
criteria selected.   
 
You can select any date range, sort the report by Performed Date, Horse Name, 
Order Entered, search either in the Performed Date or the Entered Date, select 
horses that are boarding or not or with activity or not.   
 
You can also select by the “Farm”, “Horse”, “Location”, “User ID”, “Invoice Ref 
No”, “Barn”, “Horse Type”, “Band/Tag”, “Procedure”, “Category”, “Performed By” 
or  “Current Owner” field.  The report will show amounts charged and totals 
based on what you have selected to print. 
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TIP:  To select more than one procedure for the Procedures Performed 
Report, simply click in the box to the right of the procedure to select all of 
the procedures you want to include on your report.  Follow the same steps 
to select more than one Category. 
 
 
TIP:  To print a report to double-check your day’s entries, enter “today’s 
date” in the Starting Date and Ending Date and search in “Entered Date”.  
Next, Sort By “Ordered Entered” and submit the report either to the printer 
or the screen.  This report will show you all of the procedures that have 
been entered for that particular day in the order that you actually entered 
them. 
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2. Procedure Category 
 

 
 
This menu item prints an alphabetical list of the categories that have been 
entered into the system.  You can select to show Inactive Procedure Category 
Records or not. 
 

 
 
 
 
3. Procedure Master 

 
This menu item prints a list of procedures that have been entered into the system 
either sorted by category or not.   You can select to show Inactive Procedure 
Master records or not. 
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4. Schedule Master 
 
This menu item prints a list of all of the scheduled procedures that have been 
entered into the system. 
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5. Scheduled Procedures Due 
 

o Select “Procedures” from the menu 
o Select “Reports” from the menu 
o Select “Scheduled Procedures Due” menu item 

 

 
 

o Select a date range to print.  You might want to see what 
procedures have been scheduled for one day, one week, one 
month or even one year.   

 
o Once you have selected a date range, you have the option to 

further limit the report by selecting other criteria. 
 To group all horses in the list by location, check the box 

“Group By Location?” 
 This report defaults to show horses “Currently Boarding 

Only?”  Uncheck this box if you want to see all horses on the 
report, even if they are no longer currently boarding. 

 If you want to see everything that is scheduled for “In-Foal” 
mares only, check the box next to “Include Only In-Foal 
Mares?” and leave the other fields blank. 

 If you want to see everything that is scheduled for all horses 
on one particular farm, select the specific farm name from 
the drop down list and leave the other fields blank. 

 If you want to see everything that is scheduled for one 
particular horse, select the one horse’s name from the drop 
down list and leave the other fields blank. 

 If you want to see everything that is scheduled for one 
particular horse type, select that particular horse type from 
the drop down list and leave the other fields blank. 

 If you want to see all horses that have been scheduled for a 
particular procedure, select the specific procedure from the 
drop down list and leave the other fields blank. 
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 If you want to see all horses of one horse type that have 
been scheduled for a particular procedure, first select the 
specific horse type from the drop down list and then select 
the specific procedure from the drop down list and leave the 
other fields blank. 

 If you want to see everything that is scheduled for a horse 
with a particular Band/Tag number, select that particular 
Band/Tag number from the drop down list and leave the 
other fields blank. 

 If you want to see all horses that have been scheduled for all 
procedures in a particular category, select the specific 
category from the drop down list and leave the other fields 
blank. 

 
 
Note: The Schedule Procedures Due Report will provide you with a list of what 
should be done to your horses based on what has been entered in the Schedule 
Master screen.  Because it has been scheduled does not mean that the 
procedure has actually been performed on a horse or a group of horses. 
 
 
NOTE:  When the due date in the Schedule Master screen has passed for a 
scheduled procedure, that scheduled procedure will appear as (Past Due) 
on the procedure Detail screen and (Over Due) on the Scheduled 
Procedures Due Report. 
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Mare Reports 
 

 
 

1.  Foaling  Report 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Foaling” 
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 Select the date range you want to see 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see all foals at all farms. 
 [Optional] Group by Farm 
 [Optional] Show only currently boarding mares 
 [Optional] Format the report to be exported  
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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The Foaling Report will display the information from the “Foaling Info” page 
on the “Mare Entry/Edit” screen.   
 

 
 
 

 
 

 The Foaling Report shows the sequence number of the mare, the 
mare’s name, the name of the stallion that the mare was bred to in the 
previous season, the color of the foal, the sex of the foal, the date the 
mare foaled, what time the mare foaled and any comments that were 
entered in the “Foaling Info” screen. 
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2.  Breeding  Report 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Breeding” 

 
 

 Select the Season 
 Select one particular farm or leave “Farm” as <All> to see all mares at 

all farms 
 If you want the report to be Grouped by farm, click in the box next to 

“Group By Farm”  
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 

 

 
 
This report lists the sequence number of the mare, how many times the mare 
was bred, the mare’s name, the last day the mare was bred, whether the last 
day bred was a double, the name of the stallion she was last bred to, how 
many days since the mare was last bred and the status of the mare after her 
last exam. 
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 As mares are re-bred, their names will automatically be re-arranged in 

chronological order. 
 The Status column displays information that is in the “Last Exam” field 

on the Mare Entry/Edit screen. 
 

 
 
 
 

3.  Outside Bookings 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Outside Bookings” 
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 Select the date range you want to see 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see the outside bookings for all mares at all farms. 
 Click the box  “Show Cancelled Bookings” if you want the report to show 

the bookings that have been cancelled.  If this box is blank, no cancelled 
bookings will print on the report. 

 Select to Preview the report or send it directly to the Printer 
 Click Submit. 

 

 
 

 The Outside Bookings report will show you what day of the week the 
mare is scheduled (Mon, Tue, etc.), the actual date the mare is 
scheduled to be bred (m/dd/yyyy), the time the mare is booked, the 
mare’s name, the name of the stallion the mare is booked to, the name 
and phone number of the farm where the stallion stands, the breeding 
requirements at the stallion farm, who will van the mare to the breeding 
shed and what time they will pick her up. 

 Additionally, the Outside Bookings report will show any booking 
comments that have been entered on the “Breeding Dates Entry/Edit” 
screen and whether or not the mare was Bred or the breeding was 
**Cancelled**.   
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4.  Farm Mares Bred Summary 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Farm Mares Bred Summary” 
 

 
 
 Select the Breeding Season. 
 Select one particular stallion from the drop down list or leave “Stallion” as 

<All> to see all stallions. 
 Select one particular Farm from the drop down list or leave “Farm” as 

<All> to see all farms 
 Select whether to sort the report by how many “Days Since Last Bred” or 

alphabetically by the “Mare Name”. 
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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 The “Farm Mares Bred Summary” report shows the mare’s name, what 
her status was at the beginning of the Breeding Season, her foaling 
date, the name of the Stallion she was bred to, all of her breeding 
dates for the selected Breeding Season, how many days since she 
was last bred, her final status and her projected foaling date for the 
next year. 

 If the mare was bred to more than one stallion in a breeding season, 
each stallion’s name will be displayed. (A) 

 The “Begin Status” is pulled from the Mare Entry/Edit > Mare Info 
screen “Starting Status” field. 

 The “Final Status” is pulled from the Mare Entry/Edit > Mare Info 
screen “Final Status” field. 

 The “Projected Foaling Date” is calculated based on what you entered 
in Setup > Preferences > Mare/Foal Settings (Days Between Last Day 
Bred and Foaling Date).  The value for “Due Date” can be any number 
that you want to enter.   

  

 
 
 

A
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5.  Broodmare Listing 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Broodmares” 
 

 
 
 Select the “Season” 
 Select one particular Farm from the drop down list or leave “Farm” as 

<All> to see all farms 
 [Optional] Show only currently boarding mares 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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 This report will show information for the previous breeding season and the 

selected season for each broodmare. 
 The previous season will show the name of the stallion the mare was bred 

to, the farm where the stallion stands, the name of the person that 
confirmed the booking and the date the booking was confirmed, the last 
bred date, the foaling date, the foal color and the foal sex. 

 The current season will show the name of the stallion, the name of the 
farm where the stallion stands, the name of the contact person at the 
stallion farm, the Breeding Requirements for the stallion farm, the stallion 
farm’s phone number, the share number being used, the owner of the 
Share/Season, the name of the person that confirmed the booking and the 
date the booking was confirmed.   

 It also shows the beginning status for the selected season, the last day 
bred, the status of the mare after her Last Exam, the Final Status of the 
mare and any mare comments that were entered on the mare information 
screen. 
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6.  Mare List by Client 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Mare List By Client” 
 

 
 
 Select the “Season” 
 Select a particular farm from the drop down list or leave “Farm” as <All> to 

include all farms in the report. 
 Select a particular owner from the drop down list or leave “Owner” as 

<All> to include all owners in the report. 
 If the “Show Only Currently Boarding” is checked, only those horses that 

are currently boarding will be shown on the report. 
 If the “Sort by farm” is checked, the report will sort alphabetically by farm 

name.   
 If the Sort By “Owner” is checked, the report will sort alphabetically by the 

client’s last name. 
 Select to Preview the report or send it directly to the Printer 
 Click Submit 
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 This report will show the Owner’s Name, the Percent Owned, the Mare 
name, the horse Type, the name of the Farm where the mare is, the 
Season year (Previous Season and Selected Season), the name of the 
stallion that the mare was bred to, the last day the mare was bred, the 
Status After the Last Exam, the Final Status, the date the mare foaled 
and the foal color & sex. 

 The Status After Last Exam information is populated from the “Status 
After Exam” field on the “Mare Entry/Edit” screen and the Final Status 
is also populated from the “Final Status” field on the “Mare Entry/Edit” 
screen. 

 
 
 
7. Teasing Worksheet 
 This produces a worksheet where teasing results and comments can be 
noted and then later entered into HFM. 
 

 Select “Reports” 
 Select “Mare Reports” 
 Select “Teasing Worksheet” 
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 Select the date for current results. 
 Select a specific farm from the drop down list or leave Farm as <All> to 

print worksheets for all farms. 
 

 
 
This report shows the mare name, the date the mare is due to foal, the actual 
foaling date, the last day she was bred, the results from the last 7 days of teasing 
(based on the result date selected) and an area to note the current day’s teasing 
results and comments. 

 The “Due Date” is calculated based on what you entered in Setup > 
Preferences > Mare/Foal Settings (Days Between Last Day Bred and 
Foaling Date).  The value for “Due Date” can be any number that you 
want to enter.   
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8.  Teasing Results Report 
 Select “Reports” 
 Select “Mare Reports” 
 Select “Teasing Results Report” 
 

 
 
 Select the season from the drop down list. 
 Select a specific farm from the drop down list or leave “Farm” as <All> to 

see all farms. 
 Select an owner from the drop down list or leave “Owner” as <All> to see 

teasing results for all horses 
 Select a specific horse type from the drop down list or leave “Horse Type” 

as <All> to see teasing results for all horse types. 
 Select a horse from the drop down list or leave “Horse” as <All> to see 

teasing results for all horses or select a Band Tag from the drop down list 
instead of the horse name. 

 Select to sort the report by Farm or Horse.  If sorted by Farm, the report 
will list the farms in alphabetical order and then the horses within each 
farm alphabetically.  If sorted by Horse, the report will list alphabetically by 
horse name regardless of the farm. 

 Select the month range. 
 Select to Preview the report or send it directly to the Printer 
 Click Submit. 
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This report will show the mare name, the name of the farm, the mare’s sire, 
dam, color, YOB, stallion bred to previous season and LDB previous season, 
current foaling date, color and sex of the foal, stallion booked to in current 
season, beginning status and final status for current season. 
 
This report will show any Teasing results that have been entered for each 
horse (Mare Info > Mares >Teasing Info.) or (Mare Info > Teasing Results 
Entry).  Additionally, this report will show entries for LO, RO, Cervix & Other 
(Master File > Procedure Master > “Procedure Types: Results on Teasing 
Chart & Update Mare Exam Status) 
See Example (A)
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Example (A) 
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9.  Foaling Mares By Location 
 

 Select “Reports” 
 Select “Mare Reports” 
 Select “Foaling Mares By Location” 

 

 
  

 Select the season from the drop down list. 
 Select a specific Stallion from the drop down list or leave “Stallion” as 

<All> to see all Stallions. 
 Select a specific Farm from the drop down list or leave “Farm” as <All> to 

see all Farms 
 Select a specific Location from the drop down list or leave “Location” blank 

to see all Locations.  
o The Location items are found in Setup > Master Lists > Location 
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 If the “Show Only Currently Boarding” is checked, only those horses that 
are currently boarding will be shown on the report. 

 If the Sort by “Days Since Last Bred” is checked, the report will sort 
chronologically by the days since the mare was last bred.   

 If the Sort By “Mare Name” is checked, the report will sort alphabetically 
by the mare’s name. 

 Select to Preview the report or send it directly to the Printer 
 Click Submit 

 
This report groups first by Location and shows the Mare name, the Stallion she 
was bred to for the season that was selected, the last date she was bred for the 
season that was selected, the Days Since she was last bred, the Final Status for 
the season that was selected and the Projected Foaling Date. 
 

 Note:  The Projected Foaling Date is set up in The “Projected Foaling 
Date” is calculated based on what you entered in Setup > Preferences 
> Mare/Foal Settings (Days Between Last Day Bred and Foaling Date).  
The value for “Due Date” can be any number that you want to enter.   
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Note:  This Report will show only those mares that have been marked as “In-
Foal” in the Final Status field on the Mare Information page. 
 

 
 
 

 
 
 
 



 

 
  Page 271 of 324

Fertility Analysis Reports 
 

 
 

1.  Farm-Mares: Mares by Month 
 Select “Reports”  
 Select “Fertility Analysis Reports” 
 Select “Farm-Mares:  Mares by Month” 

 

 
 

 Select the season year. 
 Status to Use:  Select “Final” if you want the report to be calculated 

based on the “Final Status” of the mare. 
 Status to Use:  Select “After Last Exam” if you want the report to be 

calculated based on the Status after the Last Exam of the mare.  
(Important:  See NOTE below) 

 Select the Run Period (Northern Hemisphere/Southern Hemisphere) 
 Select to Preview the report or send it directly to the Printer 
 Click Submit 
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2. Farm-Mares: Mares by Mare Type 

 Select “Reports”  
 Select “Fertility Analysis Reports” 
 Select “Farm-Mares: Mares by Mare Type” 

 

 
 

 Select the season year. 
 Status to Use:  Select “Final” if you want the report to be calculated 

based on the “Final Status” of the mare. 
 Status to Use:  Select “After Last Exam” if you want the report to be 

calculated based on the Status after the Last Exam of the mare.  (See 
NOTE below) 
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 Select to Preview the report or send it directly to the Printer 
 Click Submit 

 

 
 

 
 
3. Farm-Mares: Mares by Stud Farm 

 Select “Reports”  
 Select “Fertility Analysis Reports” 
 Select “Farm-Mares: Mares by Stud Farm” 

 

 
 

 Select the season year. 
 Status to Use: Select “Final” if you want the report to be calculated 

based on the “Final Status” of the mare. 
 Status to Use:  Select “After Last Exam” if you want the report to be 

calculated based on the Status after the Last Exam of the mare.  (See 
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NOTE below) 
 Group by mare’s farm:  If this box is checked, each mare farm will be 

grouped together.  If this box is blank, the report will print the analysis 
without grouping the information based on the mare farm. 

 Select to Preview the report or send it directly to the Printer 
 Click Submit 

 

 
 
 
IMPORTANT NOTE:  In order for the system to calculate the Fertility Analysis 
Reports correctly, you must enter a Final Status or a Status After Exam in the 
appropriate field on the Mare Information page.   
 
The Final Status must be selected from the drop down list and has to be an entry 
from the Master Lists Category “Mare Status” that is indicated as System 
Defined True.  See (A) 
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The default settings for Status After Exam have to be entered as Barren, Maiden, 
Not Bred, Open, Slipped or SL or Unknown. To indicate a pregnancy, you must 
enter Pg, Preg, PD, Pg+ or any word of your choice that begins with the letter 
“P”.   
 
When calculating fertility based on Status After Exam, the system will determine 
the percentages based on the following default settings 
: 

“P” =   Pregnant 
      “B” =   Barren 
      “SL” = Slipped 
      Anything else = Unknown 
 
 
 
 
 
 
 
 
 
 
 

A 
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OR 
  
You can go to Setup > Preferences > Company Settings and enter your own 
Fertility Analysis codes for the Status After Exam calculations. 
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Labels 
 

 
 
 

 
 Avery Label: Select a pre-defined Avery Label from the drop down list 
 Start on Label #:  This screen defaults to start on Label #1.  If not starting 

on the first label, select the label number by clicking the up/down arrows.  
For example, if you have used the first 3 labels on a sheet, you can tell the 
system to start printing labels on the 4th label of that sheet. 

 Sort By:  Select to print the labels sorted either alphabetically by client 
name or numerically by ZIP Code. 

 Client:  Select to show Active Only and/or Boarding Only 
 Client Filter:  Select a Category from the drop down list and leave Client 

Name as <All> to see all clients that have been identified as being 
included in that Category.  The Client Filter Categories are set up in Setup 
> Master Lists > Mailing Code and then individually selected on the Client 
Master File > Mailing Codes tab. 
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 Invoices:  If you have generated monthly billing and have not yet finalized, 
you can print labels for those clients that are included in this billing. Select 
the name of your billing from the drop down list (Standard, Monthly, etc.).  

 Sort by Name or ZIP Code  
 Output the report either to the Printer or to the Screen 
 Click on the Submit button to print the report. 

 
 Farm:  If you want to print labels for all farms that have been entered into 

the system, click “Farm”. 
 Sort By:  Select to print the labels sorted either alphabetically by farm 

name or numerically by ZIP Code. 
 Select to show Active Only or not  
 Click on the Submit button to print the report 
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Report Writer 
 
This menu option will allow you to create custom reports based on an established 
list of “Available Fields”. 
 
 
To Begin 
Select “Reports” 
Select “Report Writer” 
 

 
Click “New” to create a New Report 
Or click “Open” to open an existing report 
 
 

 
 
Report Setup 
For a new report, choose the report data set “Standard” from the drop down list. 
Report Title:  Enter a name for the report 
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Click “Private” if you do not wish to share the report across your network (if your 
HFM software is networked). 
Report Layout:  Select “Portrait” or “Landscape” 
Select a different Font and Size if needed. 
 
Next, click on the Select Fields tab. 
 

 
 
When you select the fields you want to include in your report they will appear at 
the bottom of the screen in the “Sample Data” area. 
 
Once you have selected all of the fields you want to include in your report, click 
on the “Filters” tab.  The filters tab will allow you to limit the report based on the 
criteria you select.   
 
For example, you may want to include only those horses that are currently 
boarding or you may want a report with breeding information or foaling 
information from one specific breeding season. 
 
First select the Field from the drop down list, then select the Condition from the 
drop down list and then select the Value from the drop down list and click the 
button “Add as And”. 
 
Once you have selected all of the criteria you can click “Finish” or “Print” to see 
the report.  If you are satisfied with the report you can click “Save” to save the 
report and retrieve it again when needed. 
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Samples of Filters 
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For advanced reports we recommend that you call The Jockey Club directly 
(800) 333-1778 or (859) 224-2800 to get detailed information on how to create 
more complex reports using the Report Writer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
  Page 284 of 324

 
 
 

Setup 

Setup 
 

 
 

1.  Companies 
o Select  “Setup” from the menu 
o Select  “Companies” 
o On the Company Search screen, highlight the name “Place Your Name 

HERE” and click the Edit button. 
o On the Company screen, go to the “Name” field, DELETE the words 

“Place Your Name HERE” and type in your own company/farm name.   
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o Enter your complete address  
o Enter your Phone/E-Mail information.                                                                                  
o To enter your Phone/E-Mail Entries, click the “New” button at the 

bottom of the screen and select the Type of entry from the drop down 
list.  Enter a Description if you need one or just leave the description 
blank.  

o Click “Save” when done.  You can come back to this screen at a later 
time and set up additional companies if you need to.                                                    

 
TIP: If your company logo is available and you want it to appear on your 

invoices, click “New”, browse for your logo and then click the box 
“Show on Invoice”. 

TIP:   If you select a logo that is too large you will get this message.  Click 
“OK” and browse for a smaller logo or re-size the selected logo and 
try again. 

 

 
 
 

2.  Preferences 
 

 
 

The Preferences section allows you to change some of the default settings 
for HFM in the following areas: 

 - Application Settings 
     Mare/Foal Settings 
 - Company Settings 
 - Billing Settings 
     Standard Billing Settings 
 - User Settings 
 - Email Settings 
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     Application Settings 
 

 
 

o If you want to be able to type horse names in lower case and let the 
system automatically convert them to uppercase, check the box next to 
“Capitalize All Horse Names” 

 
 
Mare/Foal Settings 
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o Days Between Last Day Bred and Foaling Date.  This number is pre-

populated but can be changed. This is the number used to calculate 
the projected foaling date which shows up on the Mares Bred 
Summary Report and the Due Date on the Teasing Worksheet. 

o New Foal Naming.  Select whether you want a new foal’s name to 
begin with the dam name or the season year. 

 
o Stallion Mare pertains only to those farms that have purchased the 

HFM Stallion Module. 
 
 

Company Settings 
 

 
 
o Band/Tag Numbers.  Select to enable the Band/Tag Field and whether 

or not you want the Band/Tag Number to be displayed before a horse’s 
name. 

o Select the default breed from the drop down list 
o Select your own farm name from the drop down list as the “Default 

Farm” 
o It is important to make note of the Location and Name of the Save 

Folder.  This folder will hold all of the saved invoices from the closed 
billing periods and it should be backed up on a regular basis. 

o Fertility Analysis Codes.  These codes refer to the Status After Last 
Exam field on the mare information page.  These codes determine the 
status of a mare when calculating fertility based on the code that has 
been used in the Status After Last Exam field on the mare information 
page. 
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Billing Settings 
 

 
 

 Print Company Name on Invoices 
o If you want your name, address, etc. to automatically appear as the 

heading on your invoices, leave the “” marked in the box.  If you are 
using pre-printed stationery and do not want the system to 
automatically generate the heading, simply un-check the box next to 
Print Company Name on Invoice to remove the “”. 

 
 Print Board Descriptions on Invoice 

o Invoices usually show “Board @ $xx.xx per day”.  If the Print Board 
Type Description On Invoice is checked, the invoice will show “Sales 
Prep @ $xx.xx per day”. 

 
 Check for Duplicate Procedures 

o This option will warn you if you have entered a duplicate item within the 
same entry set 

 
Disable the Warning When Removing A Billing Option On Procedure 
Detail 
o If you DO NOT want the system to warn you that you have removed a 

procedure from invoicing, check the box next to “Disable the Warning 
When Removing A Billing Option On Procedure Detail”. 

 
Tax Name 
o For Non-US clients, enter the tax name that will be used in billing (such 

as HST, VAT). 
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Display Auto-Allocation Options 
o When this box is checked, options will be displayed to help automate 

the process of applying credit invoices and unapplied payments to 
outstanding invoices.   

 
 
Billing Settings > Standard 
 

 
 
o Default Standard Service Charge. Select the default service charge 

from the drop down menu. This will auto-populate the service charge 
field on the client master file each time a new client is added to the 
program. 

o Standard Billing Starting Invoice #.  This is the default number that will 
be used as the first number on your first invoice generated through the 
billing menu. This number can be changed but it has to be a number 
that is greater than the default shown. 

o Summarize Invoice History Details.  If checked, the invoice will be 
shown in summary format. If unchecked the invoice will be shown in 
detail format. 

o Show Horse Charge Details on Invoice.  If checked, the invoice will 
print the detail page for all of the horse charges.  If unchecked the 
details will not be printed. 

o Show Procedure Summary on Invoice. If checked, the invoice will print 
the charges by category page.  If unchecked there will be no summary 
page printed. 

o Use double window envelope. If checked, the invoice heading will be 
shifted so that the address shows through the double window 
envelope. 
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o Standard Billing Invoice Comments.  Enter any information in this area 

that you want to appear on client invoices such as: Net 30, Payable 
Upon Receipt or Happy Holidays. The text that is entered here will 
appear on the first page of all client invoices. 

 
 
User Settings 
 

 
 
o If you want your reports to print to the screen first before printing to a 

printer, check the box next to “Default All Reports To The Screen” 
o Each person can select his/her own Required Field Color and the 

Alternate Required Field Color from the drop down list.  This setting is 
for an individual’s workstation, not all of the workstations if you are on 
a network. 

o Show reports with formatting bands.  If checked, all reports will display 
formatting bands. If this option is unchecked there will be no formatting 
bands on any of the reports.   
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Email Settings 
 

 
 
Please contact The Jockey Club directly for detailed instructions on how to 
set up your Email.  (800) 333-1778 or (859) 224-2800 
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3.  Master Lists 

No changes are needed to the Master Lists unless your farm uses a 
different set of terms or if you would like to add additional items to a 
Category. 

 
o Select  “Setup” from the menu 
o Select  “Master Lists” 
o Select the category that you wish to review from the drop down list. 

Once you select a Category, the items in that category will be 
displayed on the screen. 
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o You can add more items to a category by clicking the “New” button and 
typing your entry on the new blank line. 

 
 

4.  Billing Setup 
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Billing Codes 
 

 
 
 

 
 

o “Description” can be changed  
o “Default Debit Account” can be changed 
o “Default Credit Account” must be selected from the drop down list. 
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A/R Maintenance 
Initial A/R Client Balances for New Users Only 
 

 Select “Setup”  
 Select “Billing Setup”  
 Select “A/R Maintenance” 
 A list is displayed with all of the clients that you have entered into the 

system. 
 

 
 

 Add the ending balances for each client from your previous billing.  
(You can put the full amount in the current column or you may want to 
break down the amount owed into Current, Over 30, Over 60, Over 90 
and Service Charges in order for the Aged A/R Balance Reports to be 
correct.) 

 
Note:  The amounts entered in this table will be reflected as the beginning 
balance on the first billing run performed on HFM.  
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 Important: You can only edit A/R balances in this manner during your 

initial install/configuration process. Once you have Generated and 
Finalized a billing, you can no longer edit information on this page. 
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Service Charge [optional] 
 
If you charge late fees for unpaid invoices, you will enter codes for each 
rate you plan to use.  The Horse Farm Management System will 
automatically apply a “late fee” to any unpaid balances for those clients 
that you specifically indicate should be charged late fees/service charges.  
A client will never be charged late fees unless you specifically mark it as 
such. To set up the Service Charges/Late Fees: 
 
o Select “Setup”  
o Select “Billing Setup”  
o Select “Service Charge” 
o Click the button “New” to add each Service Charge 

 

 
 

Each line can have a different Service Charge Code with different 
percentages.  Depending on your specific needs, you can enter just one 
service charge type or several.  Click the button “New” then enter the 
Service Charge Description and the rate in the 30, 60 & 90 columns.   
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Service Tax 

(Setup > Billing Setup > Service Tax) 
Note:  This feature is used by international clients. It allows the entry of a 
service tax such as GST, HST, VAT, etc. to be charged on boarding and 
procedures. 

 
 Select “Setup” 
 Select “Billing Setup” 
 Select “Service Tax” 
 Click the button “Add” 
 Add the tax Name 
 Add the Rate 
 Add the G/L Account Number [optional] 
 Go to Setup > Preferences > Billing Settings and enter the Tax Name 

See (A) 
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 Go to Master Files > Boarding Types and select the appropriate TAX 
name from the drop down list. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

A
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 Go to Master Files > Procedure Master and select the appropriate TAX 
name from the drop down list.  

 

 
 
 
When you enter a procedure for a horse that has been marked to have the 
Service Tax applied, the information will automatically populate on the procedure 
entry screen. 
 

 
 
If you do not want a client to be charged the Services Tax, enter the Exempt 
Code on their Client master page. See (A) 
 



 

 
  Page 301 of 324

 
 
 
 
G/L Account Setup [optional] 

 
o Select “Setup” 
o Select “Billing Setup” 
o Select the “G/L Account Setup” 
 

 
 
Note: The system has been preloaded with all necessary G/L Account 

Numbers.  Only if your farm uses specific G/L accounting codes will 
you need to change the preloaded Account Numbers. 

A
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5.  Security 
 
There are two levels of security.  The first involves “Form Level Security”. 
Part (A) This level enables you to assign what forms each user can 
access.  
 
The second involves “Startup Security” and requires users to have a 
password.  Part (B) This level of security requires that a user has been 
identified as a valid user and must have a password in order to access 
HFM. 

 
Part A 
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Group Permissions 
 
The Group “Admin” will already have the default permissions set for “Full Rights”. 
 

 
 

o Click the button “New” to add each additional group  
o Next, select the Group from the drop down list and determine what forms 

they have rights to use. 
o For each “Group”, select the Rights to each of the System Areas listed. 

You can select Full Rights, Read Only Rights or No Access 
o If “Update” is checked, they will be able to read and change the record. 

(Full rights) 
o If “Read” is checked but not “Update”, they will be able to read the record 

only and not make any changes. (Read Only) 
o If “Update” and “Read” are not checked, that menu option will not be 

visible at all to the user. 
o When finished click “Save” 

 
 
 
 
 
 
 
 
 
 



 

 
  Page 304 of 324

 
Users Setup 

o Click the “Add” button to begin entering each of your users. 
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o Login:  Click “Get Network Username” or type in the name of the 
Username you wish to add. 

 
o User Info: [Optional] You can enter the first and last name of the 

individual that corresponds to the Username. 
 
o Group Membership:   First determine whether or not each user is a 

member of one of the Groups that have been established and then 
click on the group name in the Available Groups box.  Click “Add>” 
to make that user a member of that specific group.  
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o When finished click “Save” 
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Part B 
 
Security can be set to Require Login or to Require Password. 
Select Setup > Preferences > Application Settings 
 
To enable this level of security, you can check the box “Require Login” and also 
check the box “Require Password”. 
 

 
 
If “Require Password” has been checked, the Change Password screen will 
appear the first time the program is started. The user will have to identify their 
password. 
 
Change Password 
 

 
o To change your current password, select Setup > Security > Change 

Password.  Enter a new password on the first line, retype the new 
password on the second line and then click “OK”. 

o You will log into HFM with the new password you have selected. 
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Logout System 
 

 
 
 If you want to log out of HFM and not shut down your entire system, 

select “File” at the top left of the screen and then select Logout 
System. See (A)   

 If someone else wanted to access HFM on your computer they would 
have to log in under their own User ID and/or Password. 

 
 

A
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6.  Utilities 
 

 
 
 
 
Mass Boarding Entry 
 
If you want to change the boarding type for a large number of horses all at once, 
do so through “Mass Boarding Entry”.   
Be sure to make the changes starting with the oldest group first.  For instance, 
change all yearlings to two year old’s first and then change all foals/weanlings to 
yearlings. 
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 Farm:  Select a specific farm from the drop down list or leave “Farm” 
as <All> to select all Farms. 

 Horse Type:  Select a single Horse Type from the drop down list or 
leave “Horse Type” as <All> to select all Horse Types. 

 Boarding Type:  Select a single Boarding Type from the drop down list 
or leave “Boarding Type” as <All> to select all Boarding Types. 

 Barn:  Select a specific barn from the drop down list or leave “Barn” as 
<All> to select all Barns. 

 Field:  Select a specific field from the drop down list or leave “Field” as 
<All> to select all Fields. 

 Location:  Select a specific location from the drop down list or leave 
“Location” as <All> to select all Locations. 

 Click on “Apply Filter” and a list of currently boarding horses for the 
criteria you have selected will be shown in the list on the left. 

 Using the arrows in the center of the form, select all horses or certain 
particular horses and place them in the box on the right. 
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 Click on “Next” 
 

 
 Boarding Type:  Select the new boarding type 
 Start Date:  Enter the date that the new Horse Type will be effective. 
 Standard Rate:  Rate will automatically appear in this field. 
 Exception Rate:  Enter an exception rate in this field if you want all 

selected horses to get a rate that is different than what is shown as 
“Standard” 

 

A
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 Comment:  Enter any comments regarding this Boarding Type 
Change.  These comments will appear on the Mass Boarding 
Worksheet (Comment/Error) that will automatically print after you 
select “Yes”  See (A) 

 
 “Comments”:  These comments will also appear in the Boarding screen 

in the Boarding Comments area for each horse that was included in 
the “Mass Boarding Entry” group.  See (B) 

 
 

 
 
 After you have entered any comments, click on “Finished” 
 Select “Yes” to continue 
 

 
 
 The “Mass Boarding Worksheet” will automatically appear on screen. 
 

B
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 Print the worksheet if needed and then close the Mass Boarding 
Worksheet screen. 

 

 
 

 Click “Previous” to go back and create another Mass Boarding 
Entry or click “Close”. 
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Zip Codes 
 

 
 
If you need to add new Zip Codes to HFM, click “Add” then fill in the information 
in the fields provided and click “Save”. 
 

 
 
Once added, the Zip code will be available in the Address/Zip Code fields in 
HFM. 
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Screenshot 
 
If you need to make a screenshot of any one of the HFM screens that you are 
currently viewing, simply click on Utilities > Screenshot, enter a File name or 
accept the default File name and click “Save”. 
 
Once the screenshot has been saved you will be able to e-mail it to TJC should 
you have any questions about that particular screen or HFM entry. 
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Roll Back Billing 
 
If you have finalized your billing in error or have discovered a data entry error that 
you simply cannot correct via an adjusting entry, you may be able to “unlock” the 
finalized billing. 
 
Click Setup > Utilities > Roll Back Billing 
 

 
 
You will have to call TJC to get a Rollback Security Code.  Enter the code that 
the TJC support person gives to you and click “Submit”. 
 

 
This screen will show you the billing that has been finalized, the date range of the 
billing and the person that finalized it along with the date and time. 
 
Verify that the Billing Period that was last finalized is correct and click “Rollback”. 
 
A warning will appear.  Click “Yes” if you wish to continue. 
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You will receive notification that the billing has been rolled back. 
 
At this point you should make any necessary changes and corrections and then 
process the billing as usual, making sure to finalize after you have proofed each 
of the Preliminary Billing Reports. 
 
 
 
7. Registration 
 

 
 
This screen identifies the Registration Number that The Jockey Club has 
assigned to your farm/business.  When you first install HFM, TJC will provide you 
with the Registration Code. 
 
If this screen appears when you first start the program, please call The Jockey 
Club for assistance. 
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8. Online Verification 
 

 
 

Please contact The Jockey Club for instructions for setting up and using the 
Online Verification.  (800) -333-1778 or (859) 224-2800 
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Help Menu 
 

 
 

FAQ 
 
This displays a list of Frequently Asked Questions and their corresponding 
answers.  The list includes questions and answers related to Installation of HFM, 
Setup, A/R Transactions, Procedure Entry, Mare Information Entry and Billing. 
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Information for Backups 
 
This shows the location of the files you should back up on a regular basis.  The 
Database holds all of the information that you have entered into HFM and the 
Save Folder contains all of the invoices that have been saved during month end 
closing.   
 
The farm is responsible for creating backups of these files stored on their system.  
These file holds ALL of the farm’s information.  If these files get lost or damaged 
then ALL of the farm’s information will be lost or damaged. 
 
Note the location and name of your Database and your Save Folder so that you 
are sure they are included in your daily backups.  
 
You should back up these files on a regular basis.  
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SQL Loader 
 
This is used to apply patches to your database and should only be used under 
the direction of a TJCIS support person. 
 

 
 
 
 

 
Send Database to TJCIS 
    This menu option is in Development and is currently not available. 
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Check for Updates 
 

From this screen you can check your Program & Database versions, go to Fast 
Support under the direction of a TJCIS support person; you can go directly to 
The Jockey Club website or you can Upload your datafile directly to TJCIS.  
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About Horse Farm Management System 
 

 
 
 
Note:  This is an informational page.   You can check to see which HFM Version 
you are currently running.  
 
This example shows Version 4.2.2.04 See (A)  
 
NOTE:  HFM has two components.  One component is the actual Program and 
the other part is your Database.  The version number for the Program and the 
Database should always be the same.  
 
If you open up the program and get this message, it indicates that your Program 
Version and your Database version do not match.  You must contact The Jockey 
Club to rectify the problem. 
 

A 
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HOW TO REACH US 

 
 

The Jockey Club Information Systems, Inc. 
821 Corporate Drive 
Lexington, KY   40503 

 
Phone: (800) 333-1778 
             (859) 224-2800 

 
Fax:   (859) 224-2810 

 
E-Mail:  support@tjcis.com 

 
 

 
Regular business hours: 

 8:00 am – 5:00 pm (EST)  Monday – Friday 
 
 
 
 
 

Web Address for More Information 
 

www.horsefarmmanagementsoftware.com 
 

or 
 

www.tjcis.com 
 
 
 
 
 

 
 
 
 
 
 
 
 

 


